The HP DeskJet Printer
User’s Guide
For Macintosh
USB/AppleTalk Connect

895C Series
880C Series
830C Series
810C Series

English
Acknowledgments

Apple, the Apple logo, AppleTalk, ColorSync, the ColorSync logo, EtherTalk, LaserWriter, LocalTalk, Mac, Macintosh, Macintosh Quadra, Monaco, New York, PowerBook, Power Macintosh, QuickDraw, StyleWriter, and TrueType are trademarks of Apple Computer, Inc., registered in the U.S. and other countries.

Finder, Extensions Manager, and OneScanner are trademarks of Apple Computer, Inc.

Classic is a registered trademark licensed to Apple Computer, Inc.

Other company and product names mentioned herein may be trademarks of their respective companies. Mention of third-party products is for informational purposes only and constitutes neither an endorsement nor a recommendation. Neither Infowave Software, Inc. (Infowave), Apple Computer Inc. (Apple) nor Hewlett-Packard Company (HP) assumes responsibility with regard to the performance of use of the products.

Notice

The information contained in this document is subject to change without notice. Infowave, Apple and HP make no warranty of any kind with regard to this material, including, but not limited to, the implied warranties of merchantability and fitness for a particular purpose.

Infowave, Apple and HP shall not be liable for errors contained herein or for incidental or consequential damages in connection with the furnishings, performance, or use of this material.

No part of this document may be photocopied, reproduced, or translated to another language by a third party without prior written consent of the copyright holder(s).

Printing History

Copyright © 1998-99 by Infowave Software, Inc. Portions of this document are Copyright © Apple Computer, Inc., 1998-99 and are used with permission. Portions of this document are Copyright © Hewlett Packard Company, 1998-99, and are used with permission. All rights reserved.
Table of Contents

Chapter 1 Setting Up Your Printer
  Step: 1 Unpack Your Printer .............................................. 1
  Step: 2 Install Printer Software ...................................... 2
  Step: 3 Plug in the Power ............................................... 4
  Step: 4 Insert Print Cartridges ....................................... 5
  Step: 5 Load Paper ...................................................... 8
  Step: 6 Connect Your Printer to the Computer .................. 10
  Step: 7 Choosing Your Printer ....................................... 11
  Step: 8 Align the Inkjet Print Cartridges ...................... 12

Chapter 2 Using Your Printer Software
  Quick Instructions for Printing Standard Documents .......... 14
  Detailed Instructions for Using Special Features ............... 15
  Desktop Printing ..................................................... 18
  Print Dialog Options ................................................... 21
  Background Printing Settings in the Print Dialog Box .......... 25
  Monitoring and Controlling Background Printing ............... 26

Chapter 3 Creative Printing
  Paper Basics ............................................................. 30
  Custom Watermarks .................................................... 33
  Customizing Your Print Jobs ........................................ 34
  Working With Photos .................................................. 38
  Printing Envelopes .................................................... 40
  Printing Labels .......................................................... 43
  Printing Cards .......................................................... 44
  Printing Non-standard Size Cards .................................. 45
  Printing on Transparencies .......................................... 45
  Printing Posters ........................................................ 47
  Printing Banners ........................................................ 48
  Printing Iron-On Transfers .......................................... 51

Chapter 4 Using and Caring for Your Inkjet Print Cartridges
  Using Inkjet Print Cartridges ...................................... 52
  Replacing an Inkjet Print Cartridge ............................... 52
  Storing Inkjet Print Cartridges .................................... 54
  Aligning the Inkjet Print Cartridges .............................. 55
  Cleaning the Inkjet Print Cartridges .............................. 55
  Damage Resulting from Refilling the Inkjet Print Cartridges .. 59
# Table of Contents

## Chapter 5  Getting Help When Things Go Wrong
- Basic Troubleshooting .................................................. 61
- Clearing a Paper Jam ...................................................... 67
- HP Customer Care ....................................................... 68
- Extended Warranty Options ............................................ 70

## Chapter 6  More About Your Printer and Supplies
- Maintaining Your Printer .................................................. 72
- Increasing Printer Performance ........................................ 72
- Minimum Printing Margins ............................................. 73
- Ordering Supplies and Accessories ................................... 74
- Printer User’s Guides for Macintosh ................................. 75
- Paper .............................................................................. 75
- Ordering Information ..................................................... 76

## Appendix A  Specifications

## Appendix B  Legal Information
- Regulatory Notices .......................................................... 82
- Limited Warranty Statement ........................................... 83
- HP Year 2000 Warranty ................................................... 83

## Index ............................................................................. 85
Introduction

Congratulations on the purchase of your HP DeskJet printer. This User’s Guide describes how to set up the printer and how to use it.

Supported HP DeskJet Printers

The software included with this printer supports the following HP DeskJet printers:

- HP DeskJet 895C Series Printers
- HP DeskJet 880C Series Printers
- HP DeskJet 830C Series Printers
- HP DeskJet 810C Series Printers

What Comes in the Box

Here’s what comes in the box. If something is missing, talk to your HP dealer or call HP customer support. (Go to “HP Customer Care” on page 68 for the appropriate telephone number.)
Introduction

Main Features of Your HP DeskJet Printer

- Your HP DeskJet printer works with MacOS computers using a USB connection.
- Your HP DeskJet printer print high-quality color graphics and text on a variety of materials, including plain paper.
- The paper input tray holds up to 100 sheets of paper, 15 envelopes, 30 cards, and 25 sheets of labels.
- In addition, the HP DeskJet 895C Series printer is designed for use as a printer for small workgroups over a network with the HP JetDirect 300X External Print Server.

System Requirements

To install the printer software you need one of the following, depending upon the printer connection method you require:

System Requirements for USB Connection:
- PowerPC MacOS–based computer with a USB port
- MacOS version 8.1 or later
- 32 megabytes (MB) of random-access memory (RAM), and
- at least 8 MB of space available on your hard disk for the printer software.

System Requirements for EtherTalk Network Connection:
- 68040 Mac or PowerPC MacOS–based computer
- MacOS version 7.5.1 or later
- 16 megabytes (MB) of random-access memory (RAM), and
- at least 8 MB of space available on your hard drive for the printer software.

Note: The EtherTalk Network connection requires an HP JetDirect 300X External Print Server.

The Installer program automatically checks whether your computer meets these requirements.
1 Setting Up Your Printer

Step 1: Unpack Your Printer

1. Remove the packing material and the packing tape from the outside of the printer.

2. Open the top cover. Remove both pieces of plastic packing material from the inside of the printer.

3. Close the top cover.
Step 2: Install Printer Software

Before you can use your new HP DeskJet printer, you must install the printer software on every computer from which you will print.

Your printer software is located on the CD included with your printer.

If you have been using Apple’s special QuickDraw GX software, turn it off now. Your HP DeskJet printer is not compatible with QuickDraw GX.

Note: If you ever upgrade your system software (for example, from System 8.1 to System 8.5), you must reinstall the software for your printer.

Installing your software

1. Turn off any automatic virus-detection applications you have on your MacOS-based computer.

   If you don’t, problems may occur during the installation. After installation is complete, you can turn the virus-detection programs back on. (For instructions on turning off each virus-detection application, see the manual that came with the program.)

2. Insert the software CD into your CD-ROM drive.

   If necessary, double-click the HP DeskJet 800 (USB/AT) Series CD-ROM disc icon to open it. (The CD-ROM disc may already be opened on your desktop.)

3. To start the installer program, double-click HP DeskJet Mac Installer.

4. In the HP DeskJet 800 (USB/AT) Series dialog box that appears, click Continue.

   IMPORTANT! The Installer determines whether you have the correct system software, and enough memory and hard disk space to use this printer. If you don’t, the Installer displays a message telling you what you need. You won’t be able to install the printer software until you correct the system software or memory problem. If the message reports a problem, you can purchase new system software or memory from an Apple-authorized dealer.

5. Read the software license agreement and click Accept.
Setting Up Your Printer

6 In the HP DeskJet Mac Installer dialog box, click Install.

   After a few moments, the Installer begins to install the printer software. A status box keeps you informed of progress during installation.

7 When you see a message reporting that installation was successful, click Restart.

   The Installer restarts your computer.

Installation Troubleshooting

If the Installer can’t complete the installation, it displays a warning message. Here are some ways to fix common problems:

- You may not have the correct hardware or system software for this printer. If so, the Installer will tell you what you’re missing.
- You may have forgotten to turn off your virus-detection software as described in the section “Install Printer Software” on page 2.

Note: If you are unwilling to accept the terms of the agreement, click Decline. If you click Decline, the Install program exits.
Setting Up Your Printer

Step 3: Plug in the Power

1. Lift open the cable access door on the back of the printer.

2. Plug the power adapter’s cord firmly into the connector on the back of the printer.

3. Plug the appropriate end of the power cord into the power adapter.

4. Plug the other end of the power cord into an electrical outlet.

Note: Use only the Power button on the front of the printer to turn the printer on and off. Using a power strip, surge protector or a wall outlet switch to turn the printer on and off may cause premature failure.
Setting Up Your Printer

Step 4: Insert Print Cartridges

1. Press the Power button to turn on the printer.

   The Power light comes on and the Inkjet Print Cartridge light blinks.

2. Open the top cover.

   The cartridge cradles move to the center of the printer.

3. Remove the inkjet print cartridges from their individual packages.

4. Carefully remove the protective vinyl tape from the tri-color and black inkjet print cartridges.

   **Note:** Be sure not to touch the ink nozzles or the copper electrical contacts. Also, do NOT remove the copper strip; these are electrical contacts required for proper operation of the inkjet print cartridges.
Setting Up Your Printer

5 For each inkjet print cartridge, lift the cradle latch inside the printer. With the copper electrical contacts toward the rear of the printer and the inkjet print cartridge held vertically, push the inkjet print cartridge firmly down into the cradle.

Insert the black inkjet print cartridge in the right cradle, and insert the tri-color inkjet print cartridge in the left cradle. You must insert both inkjet print cartridges for the printer to operate.

6 Close the latches.

You will hear a click and feel resistance when the cradle is pushed down.

7 Close the top cover.

The Inkjet Print Cartridge light continues to blink for awhile and then goes off. (You’ll hear the cartridge cradles return to their home position on the right side of the printer.)
Setting Up Your Printer

Note: If the Inkjet Print Cartridge light continues to blink or if the cradle doesn’t move to the right side of the printer, take out both inkjet print cartridges and reinsert them.

When either inkjet print cartridge starts to run out of ink, replace the empty inkjet print cartridge. If you do not have a new replacement for the empty inkjet print cartridge, leave the empty inkjet print cartridge in the cradle of the printer. The printer will not print with only one inkjet print cartridge installed.

We recommend you keep spare inkjet print cartridges on hand. When buying inkjet print cartridges, check the part numbers referenced below carefully to make sure you are buying the right inkjet print cartridges for your printer. These inkjet print cartridges have been specifically designed to work with your printer to produce results that are always clear, always sharp.

895Cxi, 895Cse, 880C, 882C, 830C, 832C, 815C require:
- Black HP 51645 Series
- Tri-Color HP C1823 Series

810C, 812C require:
- Black HP No. 15 (equivalent to C6615A)
- Tri-Color HP No. 23 (equivalent to C1823 Series)
Setting Up Your Printer

Step 5: Load Paper

1. Pull out the lower (IN) tray and slide the paper-width and paper-length adjusters out as far as possible to make room for the paper.

2. Flip up the upper (OUT) tray for a better view of the IN tray.

3. Remove a stack of paper from its packaging. (Make sure all the paper in the stack is the same size and type.) Tap the stack on a flat surface to even it up.

4. Put the paper into the IN tray, print side down. You can insert up to 3/8 inch or 10 mm at a time.

5. Push the paper toward the back of the paper tray until it stops.

Note: Although you’ll get great print results using plain paper, Hewlett-Packard papers are developed especially for HP inks and your printer. In addition, a broad range of printing possibilities opens to you when you use the various HP papers. HP papers are available at most computer supply stores. Go to “Customizing Your Print Jobs” on page 34 for more details.
Setting Up Your Printer

5 Slide both paper adjusters to fit snugly against the paper’s edges. Make sure the paper lies flat in the tray and that the paper fits under the tab of the paper-length adjuster.

6 Then slide the IN tray all the way back in.

If it is up, flip the OUT tray back down.

Print Side Down

Most paper prints better on one side than on the other. This is especially true for coated or specially treated paper. The print side is usually indicated on the paper package. Be sure you insert the paper into the IN tray of the printer with the print side down.

For More Information:

Go to “Printing Cards” on page 44 for how to load small-sized paper. Go to “Printing Banners” on page 48 for how to print on banner paper. Go to “Customizing Your Print Jobs” on page 34 for information on papers of different sizes.
Setting Up Your Printer

Step 6: Connect Your Printer to the Computer

Connect Using a USB to USB Cable

1. Make sure your computer is turned on.

2. Lift open the cable access door on the back of the printer.

3. Plug one end of the USB cable into the USB port on the printer.

4. Plug the other end of the USB cable into the USB port on the computer.

Connect Using an HP JetDirect 300X External Print Server with the HP DeskJet 895C Series Printer

*Note: Only the HP DeskJet 895C Series printer can be used as a network printer with the HP JetDirect 300X External Print Server.*

1. Make sure your computer is turned on.

2. Connect the parallel cable to the parallel port on the back of the printer and then to the HP JetDirect 300X External Print Server.

3. Connect the HP JetDirect power cord to the power port on the HP JetDirect 300X External Print Server.

4. Plug the power cord into a grounded outlet.

5. Connect the network connection cable (not included) to the network connection port on the HP JetDirect 300X External Print Server.
Setting Up Your Printer

Step 7: Choosing Your Printer

How you select the HP DeskJet printer in the Chooser depends on whether your Mac is connected to the printer via USB or EtherTalk.

Choosing Your Printer: USB Connection

1. Make sure the computer and printer are turned on.
2. Select the Chooser from the Apple menu.
3. In the left side of the Chooser window, select the DJ 800’s (USB/AT) printer icon.
4. In the right side of the Chooser window, select whichever one of the following is displayed: DeskJet 895C, DeskJet 880C, DeskJet 882C, DeskJet 830C, DeskJet 832C, DeskJet 810C, DeskJet 812C, or DeskJet 815C.
5. Close the Chooser by clicking the close box in the Chooser’s upper-left corner.

Choosing Your Printer: EtherTalk Connection

1. Make sure the computer and printer are turned on and that both are connected to your EtherTalk network.
2. Make sure that AppleTalk is active.
   AppleTalk can be set to Active from either your AppleTalk Control Panel, or by selecting the Active button next to AppleTalk in your Chooser window. The preferred method varies depending upon which version of MacOS is running on your computer. Go to your computer’s user guide for details.
3. Select the Chooser from the Apple menu.
4. In the left side of the Chooser window, select the DJ 800’s (USB/AT) printer icon.
5. Select the printer zone if necessary.
6. In the right side of the Chooser window, select DeskJet 895C.
7. Close the Chooser by clicking the close box in the Chooser’s upper-left corner.
Setting Up Your Printer

Step 8: Align the Inkjet Print Cartridges

You're ready for the final step in setting up your printer: aligning the inkjet print cartridges to make sure you get the best print quality. Be sure to align the inkjet print cartridges whenever you install a new inkjet print cartridge.

1. Be sure the printer's IN tray contains plain paper.

2. Make sure that the paper adjusters are pushed in snug against the paper in the IN tray.

3. Turn on the printer, if necessary. The green Power button should be on.

4. Open the Read Me file that was installed with your printer software.

5. Choose Print from the File menu.

6. In the dialog box that appears, choose Background Printing from the pop-up menu.

7. Click the Foreground button if it is not already selected.

   **Note:** You cannot align the inkjet print cartridges unless foreground printing is selected.

8. Choose Services from the pop-up menu.

9. Check the Align Ink Cartridges Before Printing check box.

10. Click the Print button.

11. Examine the patterns that appear on the printed page.

12. Choose the number and letter of the best-aligned horizontal and vertical lines, and click OK.

   The printer prints a second page containing patterns you can use to verify that the alignment is acceptable.
Setting Up Your Printer

13 If the patterns on the second printed page are acceptable, click Proceed. If the patterns are not acceptable, click Align Again.

14 After you click Proceed, click OK in the remaining dialog boxes.

You have finished aligning the inkjet print cartridges in your printer.
Using Your Printer Software

Although your printer has a couple of buttons on it, you actually control the printer through your software program and the printer software you installed on your computer.

Quick Instructions for Printing Standard Documents

A standard document has the following features:

- Standard page size (US Letter in North America and A4 in Europe and Asia)
- Plain paper
- Portrait orientation
- Normal print quality

Assuming you have already selected the HP DeskJet printer in the Chooser, as described in Chapter 1, and that the printer is loaded with standard size paper, you need only follow these steps:

1. While the document is in an active window, select Print from the File menu.
   
   The Print dialog box appears on your screen.

2. Click the Print button.

   After a moment, the document starts to print. If background printing is turned on, you can continue working while the document is printing. You can also monitor and control the documents that are waiting to print. (Go to “Monitoring and Controlling Background Printing” on page 26.)
Using Your Printer Software

Detailed Instructions for Using Special Features

1. If you haven't already selected the HP DeskJet printer in the Chooser, do so now.

   If you have not selected the HP DeskJet printer, go to “Choosing Your Printer” on page 11. If you have selected the HP DeskJet and it's the only printer you ever use, you won't need to do it again. If you do need to switch, go to “Switching between printers” on page 19.

2. Load the paper, envelopes, or other media into the printer, as described in chapter 3, “Creative Printing” which begins on page 30.

3. While the document is active on your screen, choose Page Setup from the File menu.

4. Make adjustments in the following dialog box:

   ![Page Setup Dialog Box]

   - Use the Page Size pop-up to specify the size of paper that is in your paper tray.
   - Set Scaling if you want.
   - Choose landscape or portrait Orientation.

   IMPORTANT! Make sure you correctly indicate the size of the paper, envelopes, or other media you have in the paper tray. If you change the paper size in this dialog box, you might also want to look over your document to see if any of the page breaks have changed. For information on non-standard sizes, see “How to Print on Different Paper Sizes” on page 34.
5 If you’d like to print with a watermark, open the General pop-up menu and choose Watermark.

Choose the watermark you want from the Watermark pop-up menu and then adjust the Density and Scaling.
Using Your Printer Software

6 Choose Print from the File menu and make the adjustments in the dialog box that opens.

For more options, use the main pop-up menu.

Note: Clicking the Save Settings button saves the new settings as the default settings for all panels. Clicking the Revert to Default button in any of the Print dialog panels reverts the settings for all panels to their original settings. You cannot save copies, page ranges, cartridge cleaning options, or alignment options. Settings from within an application will not be saved.

7 When your printer settings are ready, click Print.
2 Using Your Printer Software

For your convenience, the Print button is available in any dialog box you use.

Desktop Printing

Use one of the two methods described here to print documents from the Finder. Desktop printing is particularly efficient either when you have a number of documents you want to print at once or when you have a document that you have already formatted. To perform desktop printing:

1 Do one of the following:
   • Drag the icons of the documents you want to print to the desktop icon of the printer you want to use.
   OR
   • Select the icons of the documents you want to print and then choose Print from the File menu. The documents will be printed on the HP DeskJet printer. (Go to “Switching between printers” on page 19.)

The Print dialog box appears.

2 Make your printing choices, then click the Print button.

Note: If background printing is turned on, you can continue working while the document is printing. You can also monitor and control the documents that are waiting to print. (Go to “Monitoring and Controlling Background Printing” on page 26.)

Creating, throwing away, and manipulating desktop printer icons

To create a desktop printer, select the HP DeskJet printer in the Chooser. After you close the Chooser, the icon appears on your desktop.

You can also do the following with desktop HP DeskJet printer icons:
Using Your Printer Software

- **Throw away the icon.** Drag the icon to the Trash. You can’t throw away a desktop printer icon while the HP DeskJet printer is printing a document.

  **Note:** You must always have at least one printer icon on your desktop. If you throw away the last icon, it is immediately re-created.

- **Rename the icon.** Rename the icon as you would any other Finder icon. Click the name to highlight it, then type the new name. This changes the name of the icon, not the name of the HP DeskJet printer.

- **Move the icon.** You can drag the icon anywhere you like.

- **Create an alias for the icon.** You can create an alias for a desktop printer (as you would for any Finder icon) by selecting the icon and choosing Make Alias from the File menu. You can move the alias anywhere on or off the desktop.

**Determining the status of a printer by looking at its icon**

You can tell the status of a printer by looking at its desktop icon:

- **Idle printer, not default.**
- **Idle printer, default.**
- **Printing on default printer.**
- **Printing stopped on default printer.**
- **Error on default printer.**
- **Printer not available or connected.**

**Switching between printers**

If you have more than one printer available, you must select which printer you want to use. The printer you select is called the **default printer.** You can change the default printer in one of three ways:

- **Select the printer using the Chooser.** If you don’t have a desktop printer icon for the printer you want to use, select the printer using the Chooser as described in “Choosing Your Printer” on page 11. The Chooser then makes it the default printer.
Using Your Printer Software

- Drag the document you want to print to a desktop printer icon. You can switch to a new default printer by dragging the icon of any document you want to print to the icon of the printer you want to use. (Go to “Desktop Printing” on page 18.)

- Select the printer using its desktop printer icon. Follow these steps to select a new default printer without immediately printing anything on it:

  1. Click the icon of the HP DeskJet desktop printer you want to use. A Printing menu appears on the menu bar at the top of the screen.

  2. Choose Set Default Printer from the Printing menu. Until you choose another printer, the Print command sends your documents to this printer.

  If you switch printers, check your document before you print it to see whether the formatting changed.
Using Your Printer Software

Print Dialog Options

On the next few pages are explanations of the options available from the Print dialog box: Paper Type/Quality, Layout, Color, and Background Printing.

Paper Type/Quality Settings in the Print Dialog Box

For highest quality printing, choose Best. Look here to see the effects of the quality options you choose.

For faster printing, choose Draft or Normal. Draft is faster than Normal.

Choose the type of paper you have in the paper tray.

To save these settings for printing future documents, click here.

To return to the default printer settings, click here.
Using Your Printer Software

Layout Settings in the Print Dialog Box

To return to the default printer settings, click here.

Select Book or Tablet to print using either of these options.

Look here to see the effects of the layout option you choose.

To save these settings for printing future documents, click here.

Note: Poster printing is not available with the HP DeskJet 810C, 812C, 830C, 832C or 815C printers. The Poster Printing option will not appear in the Print Dialog box for these printers.

Select the number of sheets of paper to be used in creating your poster.

Select 2x2, 3x3 or 4x4 Poster Printing from this pop-up menu.
Using Your Printer Software

Color Settings in the Print Dialog Box

To print several pages on one sheet of paper, select 1, 2, or 4 pages per sheet from this pop-up menu.

To print a border separating the pages in a 2- or 4-page layout, click to put an X in this check-box.

Note: Poster printing is not available with the HP DeskJet 810C, 812C, 830C, 832C or 815C printers. The Poster Printing option will not appear in the Print Dialog box for these printers.

You can choose Color, Grayscale, or Black & White from this pop-up menu.

If you choose Black & White or Grayscale from the Image pop-up menu, these options are dimmed.

To turn on Color Matching, select this check-box.

Look here to see the effects of the options you choose.

To save these settings for printing future documents, click here.
Using Your Printer Software

The ColorSync color-matching system makes sure that colors look as consistent as possible no matter what device you use to view them—monitor or printer. In addition, ColorSync helps give you the best possible colors when you export the image to another MacOS–based computer with ColorSync installed or when you print it on another color printer.

With ColorSync turned on and the Automatic matching method selected, the computer chooses the best matching method for the contents of the document you are printing. With Automatic matching, the matching method varies from object to object on each page to ensure the best matching for each object. If you are not satisfied with the results, you can choose the option you want from the Matching Method pop-up menu. Most of the time, however, the Automatic setting is best.

Note: If you are using a 13” Apple ColorSync monitor, the 13” monitor uses the default system profile. If you are using a different monitor, you should open the ColorSync control panel and select the correct system profile for your monitor or PowerBook display. For the best color, you need to choose a specific profile for your monitor. In the ColorSync control panel, choose the D50 profile for your monitor. If there is no D50 profile available for your monitor, choose Apple Multiple Scan 17—D50. The D50 profile gives you better colors.
Using Your Printer Software

Background Printing Settings in the Print Dialog Box

With background printing on, you can continue to work on your computer while printing on the HP DeskJet printer.

Select to print the document in the foreground or background. Unless you save the setting, it applies to this document only.

To save these settings for printing future documents, click here.

To return to the default printer settings, click here.

If you choose Foreground printing, you won’t be able to work on other tasks until the printing is complete, but your printing will be faster. If you choose Background Printing, you can work on other tasks while your computer prints.
Monitoring and Controlling Background Printing

If you are using background printing, you can use the desktop printer features to monitor and control your print requests.

1. Double-click the desktop printer icon of interest.

2. A window opens listing the Print Queue documents that are printing or waiting to print:

   To schedule a print time for a job, select its icon and click the clock.

   To cancel a print job, select its icon and click the Trash icon.

3. Decide what you'd like to do.

   - **To delete a print job.** Select its title or icon (by clicking it), then click the Trash icon. You can also drag the icon for the document to the Trash on your desktop. These methods delete only the print job, not the document itself.

   - **To put a print request on hold.** Select its title or icon (by clicking it), then click the pause button. The print request will stay on hold until you select its title again and click the resume button on the Print Queue dialog. You can also put the print request that's currently printing on hold by dragging it to the list of documents waiting to print.
Using Your Printer Software

- **To indicate that a print request is urgent.** Select its title or icon (by clicking it), then click the small clock. In the dialog box that appears, click Urgent. This moves the print request to the top of your list.

- **To indicate that a print request should not print until a future time.** Select its title or icon (by clicking it), then click the small clock. In the dialog box that appears, click At Time, then set the time and date you want.

- **To sort the list of items waiting to print.** Click the title of the column by which you want to sort. For example, to sort by the name of the document, click Document Name. (You can also sort by choosing the commands in the View menu.) The column title you sorted by is underlined. Sorting the items does not change the order in which they will print. To see and change the order, sort by Print Time.

- **To change the order of the items waiting to print.** Click the words Print Time, and then change the items’ place in the list by dragging and dropping their titles in the desired order.

- **To temporarily stop all your items from printing on this printer.** Choose Stop Print Queue from the Printing menu. To resume using the printer, choose Start Print Queue from the Printing menu. If you’re using a PowerBook, this can be a good way to save print requests while you’re on the road until you get back to your printer.

To move a print request from one printer to another printer of the same type, drag the icon for the print request to the icon of the printer where you want to move it. If you’re not sure whether the two printers are of the same type, try moving the print request anyway—the printer software won’t let you move a print request to an incompatible printer.
Using Your Printer Software

Services in the Print Dialog Box

Select to clean print cartridge. For details about cleaning, see Chapter 4.

To align new ink cartridges, click to put an X in this check-box.

- Clean ink cartridges before printing
  - Simple Clean
  - Clean (use more ink)
  - Super Clean (use only as last resort)

- Align ink cartridges before printing

Save Settings  Revert to Defaults  Cancel  Print
2 Using Your Printer Software
3 Creative Printing

Paper Basics

Choosing Paper

Most plain photocopy paper, postcards, index cards, transparencies, envelopes, and labels work fine in your printer, particularly paper that is marked for use in inkjet printers. To get the best results, use one of the Hewlett-Packard papers, which were developed especially for HP inks and your printer.

What to Consider

- Desired outcome. The paper you choose should be appropriate for the project. For example, use HP Greeting Card Paper when making party invitations. Or use HP Iron-On T-shirt Transfers when making T-shirts or other fabric designs for your family.

- Size. You can use any size paper that fits easily within the paper adjusters of the printer.

- Weight. You can choose from a wide range of paper weights, as listed in the “Specifications” on page 79. Use 20–24-pound or 75–90 gsm plain paper for multipurpose, everyday use.

- Brightness. Some papers are whiter than others and produce sharper, more vibrant colors. Use HP Premium Photo Paper for documents with photographs. Use HP Bright White Inkjet Paper or HP Premium Inkjet Paper for documents with any other pictures.

- Surface smoothness. The smoothness of the paper affects how crisp the printing looks on the paper. Glossy, coated paper works well for pictures and charts (where you want crisp lines with intense, high-quality colors).

- Opacity. Opacity refers to the degree to which printing on one side of the paper shows through to the other side. Use paper high in opacity (or thicker paper) for two-sided printing. HP Premium Brochure and Flyer Paper are ideal for two-sided projects.
Get the Right Paper

Your HP DeskJet printer is designed to work well on most common office paper types and with quality 25% cotton bond paper. Because your printer uses ink to produce an image, paper that accepts ink well produces the best results. Be sure to test a variety of paper types before buying large quantities.

Use HP paper for vivid color and the sharpest text. Here are some of your choices:

Inkjet Papers

- **HP Bright White Inkjet Paper** produces high-contrast colors and sharp text. This bright, white inkjet paper gives you the ability to print on both sides without show-through.
- **HP Premium Inkjet Paper.** Its matte finish captures brighter colors and sharper images for more brilliant documents and presentations.
- **HP Premium Brochure and Flyer Paper.** For professional quality inkjet printing of color brochures, flyers and other business sales materials.

Photo Papers

- **HP Premium Photo Paper** produces spectacular photographs that look and feel like traditional photos.

Specialty Products

- **HP Banner Paper** allows you to easily print banners on perforated, continuously connected sheets.
- **HP Greeting Card Paper and HP Glossy Greeting Card Paper** allows you to make your own greeting cards and invitations.
- **HP Premium Inkjet Transparency Film.** For best results with your overhead transparency presentations, this transparency film is specifically designed for use with your HP DeskJet printer.
- **HP Premium Inkjet Rapid-Dry Transparencies.** Specially formulated, this premium film makes your color presentations vivid and even more impressive. This easy-to-use film produces spectacular color and crisp, clean images that dry quickly without smudging.
Creative Printing

- **HP Restickables, Large Round and Large Inkjet Stickers.** Print high-resolution customized stickers. These repositionable stickers feature HP’s Bright White paper for bright, colorful pictures and sharp text.

HP papers are available at most computer supply stores. Go to “Ordering Supplies and Accessories” on page 74 for paper ordering information.

**Paper that Might Not Work**

- Highly textured stock, such as linen, might not print evenly; the ink could bleed into these papers.
- Extremely smooth, shiny, or coated papers not specifically designed for inkjet printers could jam the printer and might actually repel ink.
- Multi-part forms (such as duplicate or triplicate forms) could wrinkle in the printer or get stuck; the ink is also more likely to smear. In addition, only the top page is printed on.
- Paper in poor condition—with tears, dust, wrinkles, curled or bent edges, or that doesn’t lie flat—could jam the printer.
- Envelopes with thick or crooked edges; envelopes that are damaged, curled, wrinkled, or irregularly shaped; envelopes that are shiny or embossed; or envelopes with clasps or windows.
Custom Watermarks

Traditionally, a watermark is a translucent image impressed on a piece of paper that you can see only by holding the paper up to the light. Your HP DeskJet printer can't do that, but it can put an image on each page of your document, creating the illusion of a watermark. Your HP DeskJet printer comes with a number of watermarks already installed, and you can create more. Go to page 16 for information on using watermarks.

You can use any program that can save PICT format files to create your own watermarks. For example, you can create a watermark with your company's logo on it.

1 Create the file with a drawing program or any program that can save PICT files.

Here are some tips for making effective watermarks:

- Make the watermark with saturated colors. When you print a document, you can use the Density control to make the watermark lighter.
- As you draw the image, keep in mind how the watermark scaling options affect the placement of the image when it is printed.
- The printing software determines the placement of the watermark based on where it calculates the upper-left and lower-right corners of the image are. If you want to have more control over the placement, you can use your drawing program to place a dot above and to the left of the image in the watermark file to define a new upper-left corner. If you don't want the dot to be visible in your printed document, make the dot white.

2 Save the PICT file inside the Printing Prefs folder.

To find the Printing Prefs folder, open the System Folder on your hard disk, then open the Preferences folder. The name you use when saving the file will be the name that appears in the Watermark dialog box.
3 Creative Printing

Customizing Your Print Jobs

How to Print on Different Paper Sizes

If you have a special size of paper to print on, you can define its size and characteristics and add it to the Paper Size pop-up menu in the Page Setup dialog box.

1. Choose Page Setup from the File menu.
2. From the Paper Size pop-up menu, select Edit Custom Paper Sizes.
3. In the Custom Paper Size List dialog box, click New.
4. In the Custom Paper Size Info dialog box, enter the settings you want.
   - The minimum paper size you can use is 3 inches by 3 inches (77 mm by 77 mm).
   - The maximum paper size is 8.5 inches by 14 inches (215 mm by 35 mm).
5. In the Custom Paper Size List dialog box, click Done.
6. Before you print a document on the custom paper you have specified, be sure you also choose the appropriate setting from the Paper Type pop-up menu.
7. To access the Paper Type pop-up menu, choose Print from the File menu, and then choose Paper Type/Quality from the main pop-up menu.

How to Print on Both Sides of the Paper

Note: When printing across a network to the HP DeskJet 895C Series printer, this feature is not recommended.

To save paper, just put the paper through the printer twice: select a two-sided printing option and follow the directions on your screen.

1. Load the paper into the IN tray.
   - Remove any paper from the OUT tray.
2. Select Page Setup from the File menu.
   - From the Paper Size pop-up menu, select your paper size.
3 Creative Printing

3 Select Print from the File menu.

Choose Paper Type/Quality from the main pop-up menu, then select your Paper Type and Print Quality.

From Layout, click Book or Tablet. Use Tablet when the sheets of your document will be bound at the top edge. Use Book when the sheets of your document will be bound on the left.

4 Click the Print button.

The printer automatically prints only the odd-numbered pages. The printer then displays a message on your computer screen, telling you how to reload the paper.

5 Put the printed pages back into the IN tray of the printer.

The following illustrations show how to put the paper back into the printer for the Book option and the Tablet option.

Book Option
3 Creative Printing

Tablet Option

6 When the paper is properly reloaded into the IN tray, flip the OUT tray down again and follow the instruction on your screen to continue printing.

The printer prints the even-numbered pages on the reverse side of the odd-numbered pages.

What if both pages printed on one side of the paper?

You put the paper print side down when you replaced it in the printer. Print your document again, paying special attention to the instructions on your screen.

What if the ink smeared?

The ink might not have dried completely. Next time, wait longer before you print the second side. You can shorten drying times by reducing the quality of the printing—for example, change from Best to EconoFast print quality on the Print Quality setting.
Creative Printing

How to Print Several Pages Per Sheet

Your HP DeskJet printer is equipped with a special option that prints several pages on one sheet of paper. It does this by reducing the size of each page and organizing them in rows and columns on the sheet of paper.

1. Load normal-size Letter or A4 paper into the IN tray.

2. Select Page Setup from the File menu.
   From the Paper Size pop-up menu, select your paper size.

3. Select Print from the File menu.
   Choose Layout from the main pop-up menu, then click on Pages per Sheet and select from 2 or 4 pages per sheet.

4. Click the Print button.
Working With Photos

Using your own photos in your computer creations is easier to do than you may think. You can get the photos from your hands onto the computer screen in two different ways: scanning and digital film processing.

**Scanning**

If you’re using photos that have already been processed, scanning is the easiest way to get them into a usable format for your computer.

1. Use one of these methods to scan the photos:
   - If you have one, use your own scanner and its instructions.
   - Or, you can take the photos to a photo finisher and ask them to scan the photos for you.

2. Save the files onto a hard disk, floppy disk, or CD.

3. If using a floppy disk or CD, insert it into your computer.

4. Open your software program and follow its instructions to import the photos.

**Digital Film Processing**

This method of developing film places all of your pictures onto a floppy disk or CD. In addition to printed photos, you’ll receive electronic photos on floppy disk or CD that you can insert into your computer.

1. Go to your camera store or photo lab and ask for your roll of film to be processed digitally (that is, placed onto a floppy disk or CD).

2. When you receive the disk, insert the floppy disk or CD into your computer.

3. Open your software program and follow its instructions to import the photos.
Creative Printing

Printing Photos

The process for printing photos is similar to printing any other color images. The main differences are in paper and print quality selections.

Selecting the Best Photo Paper

For best results when printing photos, use one of these HP papers. Be sure to check the packaging of the HP paper for designated use with the HP DeskJet 800 (USB/AT) Series printers.

- HP Premium Photo Paper: Use HP Premium Photo Paper to produce spectacular photos that look and feel like traditional photos.

How to Print Photos

1. Select Page Setup from the File menu.
   From the Paper Size pop-up menu, select your paper size.

2. Select Print from the File menu.
   Choose Paper Type/Quality from the main pop-up menu, then select your Paper Type. HP Premium Photo Paper is recommended for photos.

3. Make sure Best is selected from the Print Quality options.

4. Load the HP Premium Photo Paper in your printer, making sure it is inserted glossy-side down.

5. Click the Print button.

For best results, remove each sheet promptly after printing and allow it to dry glossy-side up. (The drying time varies depending on the humidity.)

After you are done printing:

Remove the photo paper from the IN tray and replace it with whatever paper you’ll print on next.
Creative Printing

Printing Envelopes

Your printer provides two methods for printing envelopes:

- If you’re printing a single envelope, you can use the single-envelope slot and leave your paper in the IN tray. This allows you to print the envelope and then a letter.
- If you’re printing a stack of envelopes, use the IN tray.

Avoid shiny or embossed envelopes, or those that have clasps or windows. (Use transparent labels instead for these sorts of envelopes.) Also, envelopes with thick, irregular, or curled edges or with areas that are wrinkled, torn, or otherwise damaged could get stuck in the printer.

Follow your software instructions:

If your software program includes an envelope printing feature, follow those instructions instead of the procedure provided here.

How to Print a Single Envelope

1. Select Page Setup from the File menu.

   From the Paper Size pop-up, select the desired envelope size

2. Select Print from the File menu.

3. Click the Print button.
3 Creative Printing

How to Print a Stack of Envelopes

1 Select Page Setup from the File menu.

From the Paper Size pop-up, select the desired envelope size.

2 Slide both of the paper adjusters out.

Make sure the IN tray is empty. Flip up the OUT tray for a better view of the IN tray.

3 Put a stack of up to 15 envelopes in the printer, as shown below. (If you’re using thick envelopes, you might need to reduce the number.)

4 Slide the paper adjusters so that they fit snug against the edges of the envelope.
3 Creative Printing

About Small Envelopes

If you’re printing on small envelopes such as A2 or C6, you’ll need to push the small slider in until it fits snug against the edge of the envelopes.

5 Push the IN tray back in and flip the OUT tray down.

6 Select Print from the File menu.

7 Click the Print button

After you are done printing:

1 Remove any remaining envelopes from the IN tray and replace them with whatever paper you’ll be printing on next.

What if the printer won’t pick up the envelope?

If you’re printing a single envelope using the single-envelope slot, you might not have pushed the envelope far enough into the printer. If you’re printing a stack of envelopes, you might have included too many in the stack. Reduce the number and print again.
3 Creative Printing

Printing Labels

You can use your HP DeskJet printer to print sheets of labels. Use only A4 or U.S. Letter-sized sheets of labels. It's particularly important to pick labels that are made especially for inkjet printers. Otherwise, labels could peel off in your printer or the ink might not dry.

Sheets of labels that are folded, curled, wrinkled, or partially used can get stuck in the printer. Old labels or labels that have gotten very hot might not stick well because the glue has deteriorated.

1 Select Print from the File menu.

Choose Paper Type/Quality from the main pop-up menu, then select Plain Paper from the Paper Type pop-up and select Normal as the print quality.

2 Remove all paper from the IN tray and insert up to 20 label sheets. Flip up the OUT tray for a better view of the IN tray.

3 Slide the paper adjusters in to fit snug against the stack.

4 Push the IN tray back in and flip the OUT tray down.

5 Click the Print button.

After you are done printing:

Remove the label sheets from the IN tray and replace them with whatever paper you'll be printing on next.
3 Creative Printing

Printing Cards

Use your printer to print on index cards, recipe cards, postcards, business cards—any card size included in the Paper Size list on the Page Setup dialog. (You can print on other-sized cards, too, as described in “How to Print on Both Sides of the Paper” on page 34.)

1 Select Page Setup from the File menu.
   From the Paper Size pop-up, select the desired card size.

2 Select Print from the File menu.
   Choose Print Type/Quality from the main pop-up menu. If printing greeting cards, make the appropriate selection (either HP Greeting Card Paper or HP Glossy Greeting Card Paper) from the Paper Type pop-up menu.

3 Slide out the IN tray, slide out the paper adjusters, and flip up the OUT tray.

4 Place a stack of up to 30 cards (1/4 inch or 6 mm) in the tray.
   Make sure the orientation of the cards matches the orientation you’ve selected in your software program.

5 Slide the paper adjusters in so that they fit snug against the cards.
   Slide the paper-width adjuster to the right so that it holds the card stack snug against the right edge of the IN tray. If the cards are too small to be held securely by the paper-length adjuster, push the small slider until it fits snug against the edge of the stack.

6 Push in the IN tray and flip down the OUT tray.

7 Click the Print button.
3 Creative Printing

After you are done printing:

Remove any remaining cards from the IN tray and replace them with whatever paper you’ll print on next.

What if you want your cards to print sideways?

Make sure the orientation of the page is Landscape in your software program.
(The software program user’s guide will tell you how.)

Printing Non-standard Size Cards

If the dimensions of your card aren’t listed in the Paper Size pop-up menu, you can print it by creating a custom paper size as described in “Customizing Your Print Jobs” on page 34.

Printing on Transparencies

For best results when printing your overhead presentation, use HP Premium Inkjet Rapid-Dry Transparencies. The film coating on HP Premium Inkjet Rapid-Dry Transparencies has been especially developed to work with HP inks, giving you crisp images and text, and the fastest drying times. They won’t jam your printer, either. Look for them at large office supply stores.

1 Select Page Setup from the File menu.

If you plan to make notes on your transparencies during your presentation, select the landscape Orientation.

2 Select Print from the File menu.

Choose Paper Type/Quality from the main pop-up menu, then select HP Premium Transparency Film or HP Premium Inkjet Rapid-Dry Transparencies from the Paper Type pop-up menu.

Transparencies need longer drying times than regular paper. The printer dries them automatically before it releases them. Press the Resume button on the front of your printer to continue printing.
3 Creative Printing

It isn’t absolutely necessary to use the Best print quality, but it gives the best results. You can get terrific results, with faster printing, by using the Normal print quality. If you’re in a hurry, use EconoFast print quality.

3 Flip up the OUT tray for a better view of the IN tray.

4 Put the transparencies in your printer with the rough side down and the adhesive strip forward. (You can peel off the adhesive strip after printing.)

5 Slide in the paper adjusters, just as you would for plain paper. Push the IN tray back in and flip the OUT tray down.

6 Click the Print button.

7 Be patient when printing on HP Premium Inkjet Transparency Film or if printing on HP Premium Inkjet Rapid-Dry Transparencies in Best mode.

Because the printer uses more ink, lays the colors down more slowly, and allows for a longer drying time between sheets, transparencies take a while to print.

After you are done printing:

Remove any remaining transparencies from the IN tray and replace them with whatever paper you’ll print next.

What if the ink never dries or there are cracks in the solid blocks of color?

• You might have printed on the wrong side of the transparency. Make sure to put it into the printer rough side down.

• You might be trying to print on a transparency that wasn’t meant for an inkjet printer.

What if the quality isn’t what you were expecting?

You might not have chosen the right paper type and print quality. Follow the steps in the procedure above, and print the document again.
3 Creative Printing

Printing Posters

Note: Poster printing is not available with the HP DeskJet 810C, 812C, 830C, 832C or 815C printers. The Poster Printing option will not appear in the Print Dialog box for these printers.

1 Load normal-size Letter or A4 paper into the IN tray.

2 Select Print from the File menu.

   Choose Layout from the main pop-up menu, then click Poster Printing and select the number of sheets of paper to be used in creating your poster. Your choices are 2x2, 3x3, or 4x4.

3 Click the Print button.

   The text and pictures of each page of your document are magnified and printed across the selected sheets of paper.

4 After the document has printed and the pages are dry, trim off the white edges on each sheet. Tape the sheets together to form a poster.

After you are done printing:

   If you used heavyweight paper, remove it from the IN tray and replace it with whatever type of paper you’ll be using next.
3 Creative Printing

Printing Banners

We encourage you to use HP Banner Paper for the very best results. When you use HP Banner Paper, your banners print with brighter colors and denser blacks than if you use other banner paper. It’s easy to use, too—you don’t have to tear off those pesky perforated strips! Look for it at a large office supply store.

However, if you use computer or z-fold paper for your banners, we recommend that you use 20-pound or 75-gsm paper. Always fan the paper before loading it.

Follow your software instructions:

The software program you’re using might require special settings before it prints banners correctly on your printer. Check the ReadMe file (which was installed on your computer with the printer software) for information regarding your specific software program.

1 Select Page Setup from the File menu.

2 From the Paper Size pop-up, select U.S. Letter Banner or A4 Banner paper.

   **Note:** You must flip the banner switch to the up position, when printing an banner paper.

3 Select Print from the File menu.

   Choose Paper Type/Quality from the main pop-up menu, then select HP Banner Paper from the Paper Type pop-up menu.

4 Flip the banner switch up.

   The OUT tray lifts slightly, enabling the printer to pick up the banner paper.

5 Remove all paper from the IN tray.
Get the banner paper ready for the printer:

a. From the stack of banner paper, tear off the number of sheets you need to print the banner. (You must have at least five sheets in the stack.)

b. Tear off and discard the perforated strips, if there are any.

c. Fan the stack so that the pages don’t stick together in the printer.

Put the paper into the lower IN tray so that the unattached edge is at the top of the stack. Insert the stack’s top edge first into the IN tray until it stops.

Slide the paper adjusters so that they fit snug against the edges of the paper stack.

Push the IN tray back in.

Click the Print button.

You’ll notice that the printer goes through some start-up movements before it starts printing. Also, banner printing takes a while; it might be several minutes before you see the results.

After your banner is printed, if the Resume light is blinking, press the Resume button as many times as needed until all the banner paper is out of the printer.
3 Creative Printing

After you are done printing:

1. Flip the banner switch down.
2. Put paper into the IN tray.

What if the banner has a big gap or a crease where you don’t expect it?

- The printer might be picking up more than one sheet of paper at a time. Take the paper out, then fan the stack. Also be sure the top and bottom margins are set to zero in your banner program. Print the banner again.
- The software program from which you printed may need to be set to print on a continuous sheet instead of individual pages. See the manual provided with your software program.

What if the banner paper jams in the printer?

- You might not have clicked a Banner paper type in the Page Setup dialog.
- Put in more than five, but fewer than 20, sheets of paper.
- Make sure the banner switch (located on the printer) is up.
- See the online ReadMe file for the appropriate settings for specific software programs.
- Make sure you remove all paper before loading the banner paper.

What if you get a message that says you’re out of paper, but you’re not?

You might not have pushed the paper-length adjuster in all the way. Make sure it’s snug against the paper, and print again.

What if the text is fuzzy after printing a banner?

If the print quality seems especially poor when you switch from banner printing, you might have forgotten to reset the printer for normal printing.
Creative Printing

Printing Iron-On Transfers

When it comes to printing images, you don’t need to stop with paper. You can use transfer paper to get the images from the computer document onto cloth. You’ll need:

- the T-shirt or other cloth you want to transfer an image onto
- the document containing the picture or text you want to print
- iron-on transfer paper, which you can buy at a computer or office supply store. HP Iron-On T-Shirt Transfers are designed to work with your printer and HP ink to give you a professional silk-screened look.

Here’s how you do it

1 On your computer, open the document containing the text or picture you want to transfer to the fabric.

2 Select Page Setup from the File menu.
   If you want the text or picture on the fabric as you see it on the screen, select the landscape Orientation.

3 Select Print from the File menu.
   Choose Paper Type/Quality from the main pop-up menu, then select HP T-Shirt Transfer from the Paper Type pop-up menu.

4 Load the transfer paper printable-side down in the printer.

5 Click the Print button.

6 Follow the instructions included with the iron-on transfer paper to transfer the image onto the fabric.

After you are done printing:

Replace the transfer paper with your everyday paper.
Using and Caring for Your Inkjet Print Cartridges

Using Inkjet Print Cartridges

Each HP Inkjet print cartridge is a self-contained, plug-in ink supply. The printer operates with two inkjet print cartridges installed: one black and one tri-color. The HP printers and inkjet print cartridges are designed to work together to deliver outstanding print quality for results that are always clear, always sharp.

HP recognizes that some customers want the reliability and print quality of our HP inkjet print cartridges, but also require a lower purchase price. Other users have lower-volume printing needs and simply require less ink. By offering lower-priced, lower-volume inkjet print cartridges, HP is able to offer a choice of printing supplies ideal for the price-conscious and/or occasional printer user, while ensuring quality results. For the frequent or regular printer user, HP continues to offer the larger-volume HP inkjet print cartridges that deliver clear, sharp output at a competitive price per page. With two convenient sizes from which to choose, you can select the cartridge that fits both your printing needs and your budget.

**Note:** When buying replacement inkjet print cartridges, check the part numbers carefully so that you buy the correct cartridges for your printer.

895Cxi, 895Cse, 880C, 882C, 830C, 832C, 815C require:

- Black HP 51645 Series
- Tri-Color HP C1823 Series

810C, 812C require:

- Black HP No. 15 (equivalent to C6615A)
- Tri-Color HP No. 23 (equivalent to C1823 Series)

Replacing an Inkjet Print Cartridge

**Note:** When either inkjet print cartridge runs out of ink, replace the empty inkjet print cartridge. If you do not have a new inkjet print cartridge, leave the empty inkjet print cartridge in the cradle until you can replace it. The printer does not print with only one inkjet print cartridge installed.
Using and Caring for Your Inkjet Print Cartridges

With the printer turned on, open the top cover.

In a few moments the print cartridge cradles automatically move to the center of the printer and the Inkjet Print Cartridge light flashes.

15 Snap up the cradle latch from the top of the inkjet print cartridge to be replaced.

16 Lift the cartridge out of the cradle.

17 Discard the empty cartridge.

18 Remove the replacement inkjet print cartridge from its packaging.

19 Carefully remove the protective vinyl tape from the replacement cartridge.

**Note:** Be careful not to touch the ink nozzles or the copper contacts. Touching these parts of the inkjet print cartridge can result in clogs, ink failure, or bad electrical connection. Also, do NOT remove the copper strip; these are electrical contacts required for proper operation of the inkjet print cartridges.

20 Place the cartridge into the now-empty print cartridge cradle and push the cartridge firmly, straight down into the cradle.

21 Close the latch. You will notice some resistance when closing the latch. When the latch is fully closed, you will hear a click.

22 Close the top cover.

You’ll hear the cradle mechanism move, returning to the home position on the right side of the printer.

23 If the inkjet print cartridge light continues to blink after you install new inkjet print cartridges, check the part numbers on the inkjet print cartridges to ensure you installed the correct ones.

895Cxi, 895Cse, 880C, 882C, 830C, 832C, 815C require:

- Black HP 51645 Series
- Tri-Color HP C1823 Series
Using and Caring for Your Inkjet Print Cartridges

810C, 812C require:
- Black HP No. [15] (equivalent to C6615A)
- Tri-Color HP No. [23] (equivalent to C1823 Series)

Warning  Keep new and used inkjet print cartridges out of the reach of children.

Storing Inkjet Print Cartridges

To maintain excellent print quality from your inkjet print cartridges:

- Keep all inkjet print cartridges in their sealed packages, at room temperature (60-78 degrees F or 15.6-26.6 degrees C), until you are ready to use them.
- Keep the inkjet print cartridges in their cradles at all times to keep them from drying out or becoming clogged.
- Do not unplug the printer before printing is complete and the inkjet print cartridge cradles have returned to their home position on the right side of the printer; doing so can dry out the inkjet print cartridges.
- Turn off the printer and allow the inkjet print cartridges to return to the right side of the printer for proper capping of the nozzles before unplugging the power cord or turning off any attached power strip.
- The printer does not work with only one inkjet print cartridge installed. If one of the inkjet print cartridges runs out of ink, leave the empty inkjet print cartridge in the cradle until you can replace it.
Using and Caring for Your Inkjet Print Cartridges

Aligning the Inkjet Print Cartridges

You must use the printer software to align the black and tri-color inkjet print cartridges each time you replace or reinstall an inkjet print cartridge. This ensures that the black and tri-color inks are aligned when used together on the same line of text or within the same picture.

To align the inkjet print cartridges, follow “Align the Inkjet Print Cartridges” on page 12 of this manual.

Cleaning the Inkjet Print Cartridges

Cleaning your inkjet print cartridges can improve the quality of printing.

If your printed page is missing lines or dots, or if it contains ink streaks, perform Procedure 1 in this section. If problems persist after performing Procedure 1, perform Procedure 2 in this section.

Procedure 1: Correcting Missing Lines or Dots

Clean the inkjet print cartridges when you notice that lines or dots are missing from your printed text and graphics, as shown on the right. The inkjet print cartridges can be cleaned from the HP Toolbox.

Note: Do not clean the inkjet print cartridges unnecessarily, as this wastes ink and shortens the life of the inkjet print cartridge.
Using and Caring for Your Inkjet Print Cartridges

To Clean the Inkjet Print Cartridges from the Services dialog

1. Be sure the printer's IN tray contains plain paper.

2. Make sure that the paper adjusters are pushed in snugly against the paper in the IN tray.

3. If necessary, turn on the printer.

4. Select Print from the File menu.

   Select Background Printing from the main pop-up menu and click the Foreground button if it is not already selected. You cannot clean the inkjet print cartridges unless foreground printing is selected.

5. Select Services from the main pop-up menu.

   Click to put an X in the Clean ink cartridges before printing check-box. Try Simple Clean first. If the problem persists, try Clean or Super Clean.

6. Click the Print button.

   The printer cleans the inkjet print cartridges and print head, printing a page in the process.

   If print quality improves by going through this sequence once, but the quality is still not quite good enough, repeat the procedure. There is no harm done but a little wasted time and ink.

   If this process does not improve the print quality, your inkjet print cartridges might be low on ink. See the document provided with the black inkjet print cartridge for how to use the ink level sensor to determine if the cartridge is low on ink. Replace the inkjet print cartridges, if appropriate.

   Also, dust fibers occasionally drag through the ink and streak it. If problems persist, continue with Procedure 2.

Procedure 2: Eliminating Ink Streaks

Customers using HP DeskJet printers in dusty environments might occasionally experience ink streaks because of a small accumulation of debris inside the printer. This debris can
Using and Caring for Your Inkjet Print Cartridges

include dust, hair, carpet, or clothing fibers. Ink streaking is easily prevented or corrected by cleaning two areas of the printer: the inkjet print cartridges and the inkjet print cartridge cradle.

Materials You Will Need

Before you start, make sure you have the following materials available:

- Cotton swabs or any soft material that will not come apart or leave fibers (for example, a piece of clean cotton cloth such as a man’s handkerchief).
- Distilled, filtered, or bottled water. (Tap water may contain contaminants that can damage the inkjet print cartridges.)
- Scrap paper or paper towel on which to set the inkjet print cartridges while you are working.

Caution

Be careful not to get ink on your hands or clothing.

Remove the Inkjet Print Cartridges

1 Turn the printer on and lift the printer’s top cover.

The inkjet print cartridges move to the center of the printer.

2 After the inkjet print cartridges have moved to the center of the printer, unplug the power cord from the back of the printer.

3 Remove the inkjet print cartridges from the cradles and place them wide side down on their sides on a scrap piece of paper.

Caution

Once you’ve removed the inkjet print cartridges, make sure that they are not outside of the printer longer than 30 minutes.
4 Using and Caring for Your Inkjet Print Cartridges

Note: Be careful not to touch the ink nozzles or the copper contacts. Touching these parts of the inkjet print cartridge can result in clogs, ink failure, or bad electrical connection.

Clean the Inkjet Print Cartridges

1 Grasp the black inkjet print cartridge by the top.

2 Dip a clean cotton swab into distilled water and squeeze any excess water from the swab.

3 Clean the face and edges of the inkjet print cartridge as shown. DO NOT wipe the nozzle plate.

4 Hold the inkjet print cartridge up to the light to inspect for fibers on the face and edges. If fibers are still present, repeat steps 2 and 3.

5 Repeat steps 1-4 with the tri-color inkjet print cartridge using a clean, moistened cotton swab to avoid any contamination.

Clean the Inkjet Print Cartridge Cradle

1 Position yourself at eye level with the printer.

2 Locate the cradle that held the inkjet print cartridges.

3 Using clean, moistened swabs, wipe the underside of each wall of the carriage where fibers may collect and come in contact with the paper. Repeat until no ink residue is seen on a clean swab.
Using and Caring for Your Inkjet Print Cartridges

Reinstall the Inkjet Print Cartridges

1. Reinstall the inkjet print cartridges and close the printer’s top cover.

2. Reinsert the power cord into the back of the printer.

3. Print a page.

4. Examine the printout for ink streaking.

Note: This procedure should remove all fibers that would cause ink to streak on a printout; however, fibers can be missed. If the printout still shows streaking, repeat the procedure until the test printout is clear and sharp. This procedure and additional maintenance tips are located on the World Wide Web at: http://www.hp.com/support/home_products

Damage Resulting from Refilling the Inkjet Print Cartridges

To get the best performance from your printer, Hewlett-Packard recommends using only genuine HP supplies for HP inkjet printers, including genuine factory-filled HP inkjet print cartridges. Damage resulting from the modification or refilling of HP inkjet print cartridges is specifically excluded from coverage of HP printer warranties.

Refilling an HP inkjet print cartridge pushes the electronic and mechanical components of the inkjet print cartridge past their normal life cycle, creating many potential problems, such as:

Poor print quality

- Non-HP ink can contain components that cause nozzles to become clogged, resulting in streaked copy and graying or fuzzy characters.
- Non-HP inks can contain components that corrode the cartridge’s electrical components, resulting in poor printouts.
Using and Caring for Your Inkjet Print Cartridges

Potential damage

- If ink from a refilled cartridge leaks, the excess ink might damage the service station that caps the inkjet print cartridge while it is in the printer but not in use. Because this service station maintains the health of the inkjet print cartridge, quality problems might occur with this and future inkjet print cartridges.

- If ink from a refilled inkjet print cartridge leaks onto the electrical components in your printer, severe printer damage can occur, causing down-time and repair costs.

Caution

Damage resulting from the modification or refilling of HP inkjet print cartridges is specifically excluded from the coverage of HP printer warranties.

Note: When buying replacement inkjet print cartridges, check the part numbers carefully so that you buy the correct inkjet print cartridges for your printer.

895Cxi, 895Cse, 880C, 882C, 830C, 832C, 815C require:

- Black HP 51645 Series
- Tri-Color HP C1823 Series

810C, 812C require:

- Black HP No. [15] (equivalent to C6615A)
- Tri-Color HP No. [23] (equivalent to C1823 Series)
Getting Help When Things Go Wrong

Basic Troubleshooting

This chapter provides solutions to some problems that you may encounter while using your HP DeskJet printer.

The chooser doesn’t show the printer icon

If you open the Chooser and don’t see the printer icon, you probably need to install the appropriate printer software. For instructions, go to “Install Printer Software” on page 2.

Also, make sure the QuickDraw GX software is turned off. You can remove it from the Extensions folder or use the Extensions Manager to turn it off.

Installation is unsuccessful

If a message tells you that installation was not successful, make sure you turned off virus-detection software as explained on page 2.

The computer doesn’t recognize your printer

If you have selected your HP Deskjet printer icon in the Chooser but nothing prints, or if you get a message that the computer is unable to choose a printer, one of the conditions in the following may be the cause.

USB connection

A cable connection may be loose. To make sure that the USB cable is securely connected:

1. Unplug each end of the USB cable and plug it back in.
2. Open the Chooser and select your printer.

For detailed instructions on selecting your printer in the Chooser, go to “Choosing Your Printer” on page 11.

- You may be using the wrong printer software. Make sure you installed the software as described in “Install Printer Software” on page 2, and that you have selected the printer as described in “Choosing Your Printer” on page 11.
- The printer may need to be reset. Turn the printer off, count to five, then turn it back on.

EtherTalk Network connection

A cable connection may be loose. To make sure that all cables are securely connected:

1. Make sure both the computer and printer are connected to your EtherTalk network.
2. Turn off the computer and the printer.
3. Unplug each end of the cable you want to test.
4. Plug both ends of the cable back in.
5 Turn on the computer.
6 Turn on the printer.
7 Open the Chooser and select your printer.

For detailed instructions on selecting your printer in the Chooser, go to “Choosing Your Printer” on page 11.

- Make sure that EtherTalk or Ethernet is selected in the AppleTalk Control Panel.
- You may have indicated the wrong printer port in the Chooser. Open the Chooser and change the port selection.
- If the printer name isn’t listed in the Chooser, make sure the printer is turned on and connected to the network. Then try again to select the printer in the Chooser.
- Someone may have given the printer a new name on the network. Confirm that you are attempting to connect to the correct printer.
- You may be using the wrong printer software. Make sure you installed the software as described in “Install Printer Software” on page 2, and that you have selected the printer as described in “Choosing Your Printer” on page 11.
- The printer may need to be reset. Turn the printer off, count to five, then turn it back on.
- If multiple zones are available in the Chooser, make sure the zone that contains your printer is selected.

If you still can’t resolve the problem, the printer may not be working properly. See the information about service and support that came with your printer.

The lights indicate a problem

Sometimes the lights on the printer signal a problem:

Both lights are off

- The printer is turned off. Press the power button. If you still don’t see the glowing green light, make sure the printer is plugged into a power outlet and that the outlet has power.

Both lights blink

- Paper may be jammed in the printer. Open the front cover and remove any jammed paper. Close the front cover and turn the printer off, then on again. Go to “Clearing a Paper Jam” on page 67.
- The cartridge cradle may be jammed. Close the front cover, turn the printer off, then on again.

The power light blinks, and the resume light is off

- This is normal behavior when the printer is receiving data, printing, or waiting for ink to dry.

The power light glows steadily, and the resume light blinks

One or both of the inkjet printer cartridges may not be seated properly, or you may have forgotten to remove the tape from a new inkjet printer.
Getting Help When Things Go Wrong

cartridge. Open the front cover. Remove both inkjet printer cartridges. Holding the black plastic sides of the inkjet printer cartridge, check to be sure the tape has been removed from the print head. Then replace the inkjet printer cartridges in the cartridge cradle. Make sure each inkjet printer cartridge is pressed all the way into the cartridge cradle. If an inkjet printer cartridge feels at all loose, it is not properly seated. For instructions, go to “Insert Print Cartridges” on page 5.

- The front cover may be open. Make sure it is closed.
- There may be no paper in the lower paper tray. Load paper.
- The printer may need to reset. Press and release the Resume button.

Paper is jammed
Go to “Clearing a Paper Jam” on page 67.

Paper or envelopes feed improperly
If paper tears, gets skewed, or comes through the printer crumpled, it may not be entering the printer properly. Make sure you put paper into the IN tray correctly.

The printer won’t print a particular document
If you attempt to print a document and no page is printed—not even a blank one—try the following:

- Check for messages on your computer screen.
- Your computer may be low on memory. Try restarting it.
- Turn the printer off, then on again. (This resets the printer.)
- Repeat the printing process.

Sometimes problems disappear when you try to print your document again.

- Printing problems can often be caused by errors in your applications. If you can print from the SimpleText or TeachText application but not from another application, it’s probably a problem with that application. Contact the publisher of that application for help.
- Restart your computer.

The printer acts as if it’s working, but nothing is printed on the page
If your printer takes the paper, but doesn’t actually print anything, try the following:

- If the ink cartridge is new, make sure that you removed the tape from its print head.
- Make sure the ink cartridges are correctly installed. Go to “Insert Print Cartridges” on page 5.
- The printer may be out of ink, or the cartridges need to be cleaned. For instructions on cleaning the cartridges, go to “Cleaning the Inkjet Print Cartridges” on page 55.
Messages appear on your computer screen

Most messages that appear on your screen are self-explanatory. For example, they may tell you that the printer is out of paper or that the paper is jammed. Once you correct the problem, the message goes away.

- Restart your computer. Some software applications retain memory resources even after you have quit the application. The only way to recover this memory is to restart.

Documents did not print as expected

If the quality of printing is OK—not smeared or incomplete—but the result is not as you expected, the printer software may not have been set in the best way. For example, in the Page Setup dialog box, someone might have checked Save as Default. Make sure the settings in Page Setup are what you want, and then try printing again.

For additional help, read the subsections that follow for suggestions.

Text appears incorrect or prints jagged

When your computer is low on memory, it may display and print certain fonts other than those specified in your documents. Some text may also have jagged edges. To fix low-memory problems, try restarting your computer.

Some rotated text may print jagged if you apply a style that has not been defined for the font. Try applying plain style to the text.

Graphic images don’t print or appear jagged

Some advanced page layout and art applications use the PostScript™ page description language, a language that HP DeskJet printers do not understand. As long as your applications have a PICT preview option, you can print the file on an HP DeskJet printer, but the image may appear jagged. Also, images saved as encapsulated PostScript (EPS) may appear jagged on all non-PostScript printers. Whenever possible, use a TIFF or PICT version of the image.

Page breaks change unexpectedly

Most applications determine where to break pages by evaluating the information you provide in the Page Setup dialog box. Also, different types of printers space text in slightly different ways. The following actions can cause page breaks to change:

- changing from one type of printer to another
- changing the paper size in the Page Setup dialog box
- scaling the document in the Page Setup dialog box
- changing the orientation in the Page Setup dialog box

It’s best to choose the printer you want and the Page Setup options you need before working on your page breaks.
5 Getting Help When Things Go Wrong

A page prints off center

This problem may result from one of the following conditions:

• You have selected the wrong paper size in the Page Setup dialog box.
• The margins are set incorrectly in the document you are printing.
• Paper is not placed properly in the paper tray.

Text lines up in columns on the screen but not when it prints

You may have used spaces (rather than tabs) to line up the text. Because printers interpret spaces differently than the screen does, the text may fail to line up when you print it. Try replacing the spaces with tabs.

You can also make columns by using spaces with a monospace font—such as Courier or Monaco—instead of tabs. A monospace font is one in which every character has the same width.

Print quality is poor

Most image problems are caused by problems with an ink cartridge or with your choice of paper. Don’t use the following types of paper:

• erasable typing paper
• damaged, wrinkled, or stapled paper
• multipart forms (“carbonless carbons”)

For best print quality, use coated or glossy papers especially designed for HP DeskJet printers. If you use plain paper, use 60-135 gsm or 16- to 36-pound plain paper; 75 gsm or 20-pound paper is recommended. Plain papers can vary widely. If you’re not happy with one kind of paper, try a different brand.

The image is too light or too dark

If printing looks fuzzy because it’s too light or too dark, try the following:

• Clean the cartridges. Go to “Cleaning the Inkjet Print Cartridges” on page 55. If this doesn’t help, replace one or both ink cartridges. Go to “Replacing an Inkjet Print Cartridge” on page 52.
• Make sure you’ve chosen the correct paper type in the Print dialog box.
• If you’re using plain paper, try flipping the stack of paper in the paper tray. Most paper has one side that’s better for printing. If you’re using other material, make sure you have it loaded in the correct orientation. Go to “Load Paper” on page 8.
• Try printing on a different kind of paper.
• Try choosing Best print quality in the Print dialog box.

Thin lines fade or break up

Pick a darker color for the affected object.

The ink smears when rubbed

Don’t handle pages before the printer drops them into the output tray. Wait several minutes before handling.
Getting Help When Things Go Wrong

documents printed on glossy paper or on transparency film.

Printing appears on only part of the paper

Check the selections in the Page Setup dialog box.

Clean the inkjet printer cartridges. Go to “Cleaning the Inkjet Print Cartridges” on page 55. If this doesn’t help, replace one or both inkjet printer cartridges. Go to “Replacing an Inkjet Print Cartridge” on page 52.

Colors don’t look right on the printed page

Try the following:
  • Print a sample page to see if you’ve run out of ink.
  • Clean the inkjet printer cartridges. Go to “Cleaning the Inkjet Print Cartridges” on page 55. If this doesn’t help, replace one or both inkjet printer cartridges. Go to “Replacing an Inkjet Print Cartridge” on page 52.
  • Use a different type of paper.
  • Make sure you’ve selected the paper you’re printing on from the Paper Type pop-up menu in the Page Setup dialog box.

Unwanted horizontal white lines or stripes appear

Problems with print quality, especially horizontal white lines in your document, may mean a nozzle on the print head is clogged or your inkjet printer cartridge is running out of ink.

Clean the inkjet printer cartridges. Go to “Cleaning the Inkjet Print Cartridges” on page 55. If this doesn’t help, replace one or both inkjet printer cartridges. Go to “Replacing an Inkjet Print Cartridge” on page 52.

The image prints wavy or distorted

Make sure that you are using a recommended type of paper. If the problem persists, see the information about service and support that comes with the printer.

Stains appear on printed pages

Stains on the backs or tops of printed pages may mean that ink has spilled inside the printer. If so, the ink can transfer to the rollers and from there to the paper.

Turn the printer off and unplug it. Then open the printer and carefully clean the rollers with a soft, dry cloth.
Clearing a Paper Jam

If the paper jams in the printer:

1. Pull the paper out of either the IN tray or the OUT tray.
2. Press the Resume button on the front of the printer.
3. Press the Power button.
4. Print your document again.

If the paper jams in the back of the printer:

1. If you can’t reach the jammed paper, turn the knob on the rear access door at the back of the printer 1/4 turn counter clockwise and remove the door.
2. Pull the jammed paper out of the printer and then replace the rear access door, making sure to lock the door by turning the knob clockwise to the locked position.
3. Press the Resume button on the front of the printer.
4. Print your document again.

If you can’t see the paper causing the jam, check to see if a label has come unglued from a label sheet while going through the printer.
Getting Help When Things Go Wrong

HP Customer Care
HP DeskJet printers set the standard for quality and reliability, so you've made an excellent choice. Should you need help, however, HP Customer Care's award-winning service and support is nearby to provide expert advice on using your HP printer or to answer specific questions about a problem you are having. Whether online, by fax, or by phone, you'll find the support you need—and you'll find it fast.

Electronic Support Information
If you have a modem connected to your computer and subscribe to an online service or have direct access to the Internet, you can obtain a wide variety of information about your printer.

HP Customer Care Online
Click your way to a quick solution! A great place to go for answers to questions about HP products is HP Customer Care online at http://www.hp.com/support/home_products. You'll get instant access to everything from helpful printing tips to the latest product and software updates—24 hours a day, seven days a week.

HP Customer Care User Forums
They're friendly. They're informative. Check out our online user forums. Simply review existing messages left by other HP users to find the answers you're looking for. You can also post your questions, then check back later for ideas and suggestions from knowledgeable users and system operators. You can access the user forums directly from the http://www.hp.com/support/home_products.

HP Customer Care by Fax
When you want the facts—and you want them fast—call HP FIRST, our automated faxback service. Dial (800) 333-1917 (U.S. only) from any touch-tone phone, listen to your choices, then select the support document that matches your specific need. You may request up to three documents per call, and we'll fax them to you right away. HP FIRST is a free service, so call anytime—24 hours a day, seven days a week.

Printer Software
Printer software (also referred to as a printer driver) allows your printer to talk with your computer. You have several options for getting printer software:

- If you are in the U. S. and need a software upgrade, you can order by calling the following number: (661) 257-5565 Software upgrades are available for the cost of the disks plus shipping.
- If you are outside the U.S. and cannot download the driver from HP's Web site, call the HP Customer Care number nearest you. Go to page 69.

HP Customer Care Repair
If your HP printer is ever in need of repair, simply call the HP Customer Care Center. A trained service technician will diagnose the problem and coordinate the repair process for you. This service is free during your printer's standard warranty. Beyond the warranty period, repairs are charged on a time and materials basis.
Getting Help When Things Go Wrong

**HP Customer Care By Phone**
Within 90 days from the time of your purchase, telephone support is provided to you free of charge. However, if you are calling long distance, the long-distance charges apply. Before placing a call for help, please make sure that:

- You have checked your *User’s Guide* and online troubleshooting for installation troubleshooting tips.
- You are seated in front of your computer with your printer nearby.
- You have the following information available:
  - Your printer’s serial number (the label is on the printer’s bottom).
  - Your printer’s model number (the label is on the front of the printer).
  - The model of the computer.
  - The version of the printer driver and software program (if applicable).

**A Note About Letters**
If you need help from a technical support person, we recommend that you call us while you’re in front of your computer and printer, rather than writing a letter to us. That way we can help you with your questions immediately!

**Calling HP Customer Care**
To speak with someone for online technical assistance, call one of the following numbers. This service is free during the warranty period of your printer. However, long-distance charges will be applied.

### Africa/Middle East
- 41 22/780 41 11

### Argentina
- 54 1781-4061/69

### Australia
- 61 3 92728000

### Austria
- 43 (0)660 6386

### Belgium (Dutch)
- 32 (0)2 62688 06

### Belgium (French)
- 32 (0)2 62688 07

### Brazil
- 55 11 829-6612

### Canada
- (905) 206-4663

### China
- 86 10 6505 3888-5959

### Czech Republic
- 42 (2) 7321

### Denmark
- 45 (0)39 294099

### Finland
- 385 (0)203 47288

### France
- 33 (0) 143623434

### Germany
- 49 (0) 180 532-6222

### Greece
- 30 1 689 64 11

### Hong Kong
- 886 277 0055

### Hungary
- 36 (1) 252 4505

### India
- 91 11 682 60 35

### Indonesia
- 6221 350 3408

### Ireland
- 353 (0) 1662 5525

### Israel
- 972-9-9524848

### Italy
- 39 (0) 126 210350

### Japan, Tokyo
- 81 3 3335-8333

### Japan, Osaka
- 81 6 838 1155

### Korea
- 82 2 3270 0700

### Malaysia
- 03 2952566

### Mexico D.F.
- 326 46 00

### Mexico, Guadalajara
- 669 95 00

### Mexico, Monterrey
- 378 42 40

### Middle East/Africa
- 41 22/780 41 11

### Netherlands
- 31 (0)20 606 8751

### New Zealand
- 0 (0) 964640

### Norway
- 47 (0)22 116299

### Philippines
- 65 272 5300

### Poland
- 48 22 37 50 65

### Portugal
- 351 (0) 144 17 199

### Russia
- 7095 923 50 01

### Singapore
- 65 272 5300

### Spain
- 34 (9) 02321 123

### Sweden
- 46 (0)8 6192710

### Switzerland
- 41 (0)84 8801111

### Taiwan
- 886 2-2777-0055

### Thailand
- 66-2 661 4011

### Turkey
- 90 1 224 59 25

### United Kingdom
- 44 (0) 711252 4202

### U.S.
- (208) 344-4131

### Venezuela
- 58 2 239 5664
Getting Help When Things Go Wrong

After the Warranty

You can still get help from HP for a fee. Prices are subject to change without notice. (Online help is still available for free!)

- For quick questions in the United States only, call (900) 555-1500. The charges are $2.50 per minute and begin when you connect with a support technician.
- For calls from Canada, or for calls in the U.S. that you anticipate might be longer than ten minutes in length, call (800) 999-1148. The fee is US $25 per call, charged to your Visa or MasterCard.
- If during your phone call, it is determined that your printer requires repair, and you are within your printer’s hardware warranty period, your phone charges will be reversed.

Extended Warranty Options

If you would like to extend your printer coverage beyond the one year factory warranty, you have the following options:

- Consult your reseller to get extended coverage.
- If your reseller does not offer service contracts, please call Hewlett-Packard directly and ask about our service agreement offering. In the U.S. call (800) 446-0522; in Canada call (800) 268-1221. For service agreements outside the U.S. and Canada, contact your local HP Sales Office.
5  Getting Help When Things Go Wrong
More About Your Printer and Supplies

Maintaining Your Printer

- Use a soft cloth moistened with water to wipe off dust, smudges, and stains.
- The interior of the printer does not require cleaning. Keep fluids away from the interior of the printer.
- Do not lubricate the rod on which the inkjet print cartridge cradles move. Noise is normal when the cradle is moving back and forth within the printer.

Increasing Printer Performance

The print speed and overall performance of your printer can be affected by several things:

- The amount of RAM in your computer can determine how fast your documents are sent to the printer. Increasing the amount of RAM in your computer can speed up this process as well as make your computer work more efficiently when you are doing something besides printing.
- The printer driver that you are using to print your documents can make a significant difference in the quality of your printed output. Make sure you are using an up-to-date version of an HP printer driver designed specifically for your printer model. Go to “Printer Software” on page 68 for information on how to get an updated printer driver.
- The size and complexity of the documents you print can make a difference in your printer’s performance. Graphics and photographs are usually more complex and print more slowly than a document that contains only text.
- The processing speed of your computer determines how fast your document is sent to the printer.
- The amount of free space on your computer’s hard disk makes a difference in printing speed. If your computer has less than 100 MB of free space, it can take longer to process your document for printing.
- Running numerous software programs at one time slows down printing, because they are using the RAM in your computer. Therefore, limit the number of programs or documents you open at one time.
More About Your Printer and Supplies

Minimum Printing Margins

The printer cannot print outside a certain area of the page, so you must make sure the contents of your document fall within the printable area—that is, within the top, bottom, left, and right margins available for the specific size of paper on which you are printing.

When you use nonstandard paper sizes the paper width must be between 77 and 215 mm (3 and 8.5 inches) and the paper length must be between 77 and 356 mm (3 and 14 inches).

A4-Sized Paper

Left: 0.125 in. (3.2 mm)
Right: 0.125 in. (3.2 mm)
Top: 0.04 in. (1.0 mm)
Bottom: 0.46 in. (11.7 mm)

Margins for Letter-, Legal-, and Executive-Sized Paper

Left: 0.25 in. (6.4 mm)
Right: 0.25 in. (6.4 mm)
Top: 0.04 in. (1.0 mm)
Bottom: 0.46 in. (11.7 mm)

A5-Sized Paper

Left: 0.125 in. (3.2 mm)
Right: 0.125 in. (3.2 mm)
Top: 0.04 in. (1.0 mm)
Bottom: 0.46 in. (11.7 mm)

B5-Sized Paper

Left: 3.2 mm (0.125 in.)
Right: 3.2 mm (0.125 in.)
Top: 1.0 mm (0.04 in.)
Bottom: 11.7 mm (0.46 in.)

Cards (3x5, 4x6, 5x8, and A6)

Left: 3.2 mm (0.125 in.)
Right: 3.2 mm (0.125 in.)
Top: 1.0 mm (0.04 in.)
Bottom: 11.7 mm (0.46 in.)

Hagaki Postcards

Left: 0.125 in. (3.2 mm)
Right: 0.125 in. (3.2 mm)
Top: 0.04 in. (1.0 mm)
Bottom: 0.46 in. (11.7 mm)

Envelopes

Left: 0.04 in. (1.0 mm)
Right: 0.46 in. (11.7 mm)
Top: 0.125 in. (3.2 mm)
Bottom: 0.125 in. (3.2 mm)

Banners - A4 Sized (8.27 x 11.7 in.)

Left: 0.125 in. (3.2 mm)
Right: 0.125 in. (3.2 mm)
Top: 0.00 in. (0.0 mm)
Bottom: 0.00 in. (0.0 mm)

Banners - Letter Sized (8.5 x 11 in.)

Left: 0.25 in. (6.4 mm)
Right: 0.25 in. (6.4 mm)
Top: 0.00 in. (0.0 mm)
Bottom: 0.00 in. (0.0 mm)
More About Your Printer and Supplies

Ordering Supplies and Accessories

HP USB-Compliant Interface Cable
2-meter length C6518A

HP JetDirect Print Servers
HP JetDirect 300X Ethernet/802.3 RJ-45 (10 Base-T/100 Base-Tx) Single Port

Inkjet Print Cartridges
895Cx, 895Cse, 880C, 882C, 830C, 832C, 815C require:
- Black HP 51645 Series
- Tri-color HP C1823 Series

810C, 812C require:
- Black HP No. [15] (equivalent to C6615A)
- Tri-color HP No. [23] (equivalent to C1823 Series)

Power Adapter (worldwide)
C6409-60014

Power Cords
U.S., Canada, Brazil, Latin America, Saudi Arabia, U.K., Middle East, Singapore, Malaysia, Hong Kong, South Africa
Japan
8120-8330

8120-8336

8120-8341

8120-8791

8120-8347

8120-8345

8120-8434

8120-8337

8120-8346

8120-8339

8120-8340

India
Argentina
Australia, Argentina
China, Taiwan, Philippines
Korea
Continental Europe, Jordan, Lebanon, North Africa, Israel, Russia, Baltic countries, Thailand, Indonesia, Caribbean, Latin America

Other Replaceable Parts
DJ895C Series Printer Top Cover (Access Door Assembly) C6409-60015
DJ880C Series Printer Top Cover (Access Door Assembly) C6409-60040
DJ830C Series Printer Top Cover (Access Door Assembly) C6413-60001
DJ810C Series Printer Top Cover (Access Door Assembly) C5870-40045
Cable Access Door (I/O Cover) C6409-40014
Cleanout Access Door Assembly C4557-60076
More About Your Printer and Supplies

Printer User’s Guides for Macintosh

Be sure to check the HP Web site first for all your documentation needs. Most HP printer documentation is available in PDF format for viewing and printing from Adobe Acrobat at http://www.hp.com

Worldwide English C6413-90023
French C6413-90025
German C6411-90132
Italian C6411-90133
Spanish C6413-90027
Swedish C6411-90134
Dutch C6411-90135
Portuguese C6413-90026

Paper

HP Bright White Inkjet Paper
- 210 x 297 mm, A4, 500 sheets C1825A
- 210 x 297 mm, A4, 200 sheets C5977A
- U.S. letter, 200 sheets C5976A
- U.S. letter, 500 sheets C1824A

HP Premium Inkjet Paper
- 210 x 297 mm, A4, 200 sheets 51634Z
- U.S. letter, 200 sheets 51634Y

HP Premium Brochure and Flyer Paper
- U.S. letter, 50 sheets C6955A

HP Premium Photo Paper
- Asian A4, 15 sheets C6043A
- European A4, 15 sheets C6040A
- U.S. letter, 15 sheets C6039A

HP Premium Inkjet Transparency Film
- 210 x 297 mm, A4, 20 sheets C3832A
- 210 x 297 mm, A4, 50 sheets C3535A
- U.S. letter, 20 sheets C3828A
- U.S. letter, 50 sheets C3834A

HP Premium Inkjet Rapid-Dry Transparencies
- 210 x 297 mm, A4, 50 sheets C6053A
- U.S. letter, 50 sheets C6051A
More About Your Printer and Supplies

HP Banner Paper
210 x 297 mm, A4, 100 sheets C1821A
U.S. letter, 100 sheets C1820A

HP Greeting Card Paper
(Pre-scored for quarter-fold)
210 x 297 mm, A4, 20 sheets, 20 envelopes C6042A
U.S. letter, 20 sheets, 20 envelopes C1812A

HP Premium Glossy Hagaki Cards
Hagaki card, 20 cards C6575A

HP Glossy Greeting Card Paper
(Pre-scored for half-fold)
210 x 297 mm, A4, 10 sheets, 10 envelopes C6045A
U.S. letter, 10 sheets, 10 envelopes C6044A

HP Iron-on T-Shirt Transfers
European 210 x 297 mm, A4, 10 sheets C6050A
Asian 210 x 297 mm, A4, 10 sheets C6065A
U.S. letter, 10 sheets C6049A

HP Restickables, Large Round Inkjet Stickers
U.S. letter, 10 sheets (90 stickers) C6822A

HP Restickables, Large Square Inkjet Stickers
U.S. letter, 10 sheets (90 stickers) C6823A

Availability of special media varies by country.

Ordering Information
To order printer supplies or accessories, call your nearest HP dealer or call HP DIRECT at the following numbers for fast shipping service:

- Argentina: (54 1) 787-7100
  Fax: (54 1) 787-7213
  Hewlett-Packard Argentina, Montañoses 2150
  1428 Buenos Aires, Argentina
- Australia/New Zealand: (03) 895-2895
  China Resources Bldg.,
  26 Harbour Road
  Wanchai, Hong Kong
- Belgium: 02/778 3092 (or 3090, 3091)
  Fax: 02/778 3076
  Hewlett-Packard Belgium SA/NV
  100 bd. de la Woluwe/Woluwestral
  1200 BRUXELLES
- Brazil: 55-11-7296-4991
  Fax: 55-11-7296-4967
  Edisa Hewlett-Packard SA, R. Aruana 125,
  Tambore, Barueri, Sao Paulo, Brazil,
  06460-010
- Canada: (800) 387-3154, (905) 206-4725
  Fax: (905) 206-3485/-3739
  Hewlett-Packard (Canada) Ltd.,
  3150 Spectrum Way
  Mississauga, Ontario L4W 5G1
- Toronto: (416) 671-8383
- Chile: (56 2) 203-3233
  Fax: (56 2) 203-3234
  Hewlett-Packard de Chile SA
  Av. Andres Bello 2777, Oficina 1302
  Las Condes, Santiago, Chile
- Denmark: 45 99 14 29
  Fax: 42 81 58 10
  Hewlett-Packard A/S
  Kongevejen 25, 3460 BIRKEROD
- Finland: (90) 8872 2397
  Fax: (90) 8872 2620
  Hewlett-Packard Oy
  Varaosamuyto, Piispankalliontie 17
  02200 ESPÖO
- France: (1) 40 85 71 12
  Fax: (1) 47 98 26 08
  EuroParts, 77 101 avenue du Vieux Chemin de
  Saint-Denis
  92625 GENNEVILLIERS
### More About Your Printer and Supplies

- **Germany**: 07031-145444  
  Fax: 07031-141395  
  Hewlett-Packard GmbH, HP Express Support  
  Herrenberger Str. 130  
  7034 BOBLINGEN
- **International Sales Branch**: (41) 22 780 4111  
  Fax: (41) 22 780-4770  
  Hewlett-Packard S. A., ISB  
  39, rue de Veyrot  
  1217 MEYRIN 1, GENEVE - SUISSE
- **Italy**: 02/9212.2336/2475  
  Fax: 02/92101757  
  Hewlett-Packard Italiana S. P. A.  
  Ufficio Parti di ricambio  
  Via G. Di Vittorio, 9  
  20063 Cernusco s/N (MI)
- **Japan**: 03 3335-8333  
  Hewlett-Packard Japan Ltd.  
  29-21 Takaido-Higashi 3-chome, sugninami-ku  
  Tokyo 168-8855
- **Latin America Headquarters**: (305) 267-4220  
  Fax: (305) 267-4247  
  5200 Blue Lagoon Drive, Suite 950  
  Miami, FL 33126
- **Mexico**: (52 5) 258-4600  
  Fax: (52 1) 258-4362  
  Hewlett-Packard de México, S.A. de C.V  
  Prolongación Reforma #470  
  Colonia Lomas de Santa Fe, C.P. 01210 México, D.F.
- **Netherlands**: 0 33 450 1808  
  Fax: 0 33 456 0891  
  Hewlett-Packard Nederland B. V., Parts Direct Service  
  Basicweg 10  
  3821 BR AMERSFOORT
- **Norway**: 22735926  
  Fax: 22735611  
  Hewlett-Packard Norge A/S, Express Support  
  Drammensveien 169-171  
  0212 Oslo
- **Austria - South-East Area**: (43-0222) 25 000, ext. 755  
  Fax: (43-0222) 25 000, ext. 610  
  Hewlett-Packard Ges.m.b.H.  
  Ersatzteilverkauf  
  Lieblg. 1  
  A-1222 Wien
- **Spain**: 1 6 3114 81  
  Fax: 1 6 3112 74  
  Hewlett-Packard Espanola S.A.  
  Departamento de Venta de Piezas  
  Ctra N-VI, Km. 16,500  
  28230 LAS ROZAS, Madrid
- **Sweden**: 8-4442239  
  Fax: 8-4442116  
  Hewlett-Packard Sverige AB  
  Skalholtsgatan 9, Box 19  
  164 93 KISTA
- **Switzerland**: 056/279 286  
  Fax: 056/279 280  
  Elbatex Datentechnik AG  
  Schwimmbastrasse 45, 5430 WETTINGEN
- **United Kingdom**: 0800 227-8164  
  Parts First, Riverside Works  
  Isleworth, Middlesex, TW7 7BY
- **United States**: 918 227-8164  
  Hewlett-Packard de Venezuela C.A.  
  Tercera Transversal de Los Ruices Norte, Edificio  
  Segre, Caracas 1071, Venezuela  
  Apartado Postal 50933, Caracas 1050

### Elsewhere in the world

- Hewlett-Packard Company, Intercontinental Headquarters, 3495 Deer Creek Road, Palo Alto, CA 94304, U.S.A.
Specifications

DeskJet 895Cxi model no. C6410A
DeskJet 895Cxi model no. C6410A
DeskJet 895Cse model no. C6410B

Black Text Print Speed*

EconoFast: 11 pages per minute
Normal: 5.1 pages per minute
Best: 4.4 pages per minute

Black Text with Color Highlights Print Speed*

EconoFast: 9 pages per minute
Normal: 4.3 pages per minute
Best: 3 pages per minute

Mixed Text with Color Graphics Print Speed*

EconoFast: 8.5 pages per minute
Normal: 3.6 pages per minute
Best: 1 pages per minute

Full Page Color Print Speed*

EconoFast: 2.8 pages per minute
Normal: 1 pages per minute
Best: 0.3 pages per minute

Duty Cycle
3,000 pages per month

DeskJet 880C model no. C6409A
DeskJet 882C model no. C6409B

Black Text Print Speed*

EconoFast: 8 pages per minute
Normal: 5 pages per minute
Best: 4.3 pages per minute

Black Text with Color Highlights Print Speed*

EconoFast: 9 pages per minute
Normal: 4.3 pages per minute
Best: 3 pages per minute

Mixed Text with Color Graphics Print Speed*

EconoFast: 6.5 pages per minute
Normal: 3.6 pages per minute
Best: 1 pages per minute

Full Page Color Print Speed*

EconoFast: 2 pages per minute
Normal: 0.75 pages per minute
Best: 0.3 pages per minute

Duty Cycle
2,000 pages per month

DeskJet 810Cxi model no. C6411A
DeskJet 812Cse model no. C6411B

Black Text Print Speed*

EconoFast: 8 pages per minute
Normal: 4.6 pages per minute
Best: 4 pages per minute

Black Text with Color Highlights Print Speed*

EconoFast: 5.5 pages per minute
Normal: 3.8 pages per minute
Best: 2.6 pages per minute

Mixed Text with Color Graphics Print Speed*

EconoFast: 5 pages per minute
Normal: 3.1 pages per minute
Best: 0.8 pages per minute

Full Page Color Print Speed*

EconoFast: 1.4 pages per minute
Normal: 0.5 pages per minute
Best: 0.2 pages per minute

Duty Cycle
1,000 pages per month

DeskJet 880C model no. C6409A
DeskJet 882C model no. C6409B

Black Text Print Speed*

EconoFast: 8 pages per minute
Normal: 5 pages per minute
Best: 4.3 pages per minute

Black Text with Color Highlights Print Speed*

EconoFast: 9 pages per minute
Normal: 4.3 pages per minute
Best: 3 pages per minute

Mixed Text with Color Graphics Print Speed*

EconoFast: 6.5 pages per minute
Normal: 3.6 pages per minute
Best: 1 pages per minute

Full Page Color Print Speed*

EconoFast: 2 pages per minute
Normal: 0.75 pages per minute
Best: 0.3 pages per minute

* Approximate figures. Exact speed will vary depending on the system configuration, software program, and document complexity.
Specifications

Duty Cycle
1,000 pages per month

DeskJet 815C model no. C6411C

Black Text Print Speed*
EconoFast: 7.5 pages per minute
Normal: 4.6 pages per minute
Best: 4.0 pages per minute

Black Text with Color Highlights Print Speed*
EconoFast: 5.5 pages per minute
Normal: 3.8 pages per minute
Best: 2.6 pages per minute

Mixed Text with Color Graphics Print Speed*
EconoFast: 5 pages per minute
Normal: 3.1 pages per minute
Best: 0.8 pages per minute

Full Page Color Print Speed*
EconoFast: 1.4 pages per minute
Normal: 0.5 pages per minute
Best: 0.2 pages per minute

Print Technology
Drop-on-demand thermal inkjet printing

Software Compatibility
MacOS compatible applications

Buttons/Lights
Resume button and light
Power button and light
Banner switch
Inkjet Print Cartridge light

I/O Interface
Universal Serial Bus

Dimensions
17.56 in wide x 7.2 in high x 13.8 in deep
446 mm wide x 185 mm high x 355 mm deep

Weight
12 lbs, 5.5 kg excluding power supply and pens

Operating Environment
Maximum operating temperature:
41 to 104 degrees F, 5 to 40 degrees C
Humidity: 15 to 80% RH noncondensing
Recommended operating conditions for best print quality:
59 to 95 degrees F or 15 to 35 degrees C
20 to 80% RH noncondensing
Storage temperature: -40 to 140 degrees F, -40 to 60 degrees C

Power Consumption
5 watts maximum when off
5 watts maximum nonprinting
20 - 30 watts maximum average when printing

EconoFast: 300 x 300 dpi
Normal: 600 x 600 dpi
Best: 600 x 600 dpi

Color Resolution (depends on paper type)
EconoFast: 300 x 300 dpi
Normal: PhotoRet II
Best: PhotoRet II

Black True Type™ Resolution (depends on paper type)
EconoFast: 300 x 300 dpi
Normal: 600 x 600 dpi
Best: 600 x 600 dpi

The following specifications apply to the HP DeskJet 895C, 880C, 830C and 810C Series printers for Macintosh.
A Specifications

Power Requirements

Power Adapter (universal input)

Input Voltage: 100 to 240 VAC (±10%)  
Input Frequency: 50 to 60 Hz (±3 Hz)

Automatically accommodates the world-wide range of AC line voltages and frequencies. There is no on/off switch on the power adapter.

Declared noise emissions in accordance with ISO 9296:

Sound power level, LWAd (1B=10dB): 5.5 B in Normal mode.

Sound pressure level, LpAm (bystander positions): 42 dB in Normal mode.

Media Weight

Paper: 16 to 110 lb index (60 to 200 gsm)  
Envelopes: 20 to 24 lb (75 to 90 gsm)  
Cards: 110 lb index max; 0.012 in max thickness (110 to 200 gsm; 0.3 mm max thickness)  
Banner Paper: 20 lb (75 gsm)

Media Handling

Sheets: up to 100 sheets  
Banners: up to 20 sheets  
Envelopes: up to 15 envelopes  
Cards: up to 30 cards  
Transparencies: up to 25 sheets  
Labels: up to 20 sheets of Avery paper labels  
Use only U.S. letter-sized or A4-sized sheets. Use only paper labels specifically designed for use with HP inkjet printers.

OUT tray capacity: up to 50 sheets

Media Size

Custom size:

Width: 3.0 to 8.5 in (77 to 216 mm)  
Length: 3 to 14 in (77 to 356 mm)  
U.S. letter: 8.5 x 11 in (216 x 279 mm)  
Banner U.S. letter: 8.5 x 11 in (216 x 279 mm)  
U.S. legal: 8.5 x 14 in (216 x 356 mm)  
Executive: 7.25 x 10.5 in (184 x 267 mm)  
U.S. No. 10 envelope: 4.13 x 9.5 in (105 x 241 mm)  
Invitation A2 envelope: 4.37 x 5.75 in  
Index card: 3 x 5 in (76 x 127 mm)  
Index card: 4 x 6 in (102 x 152 mm)  
Index card: 5 x 8 in (127 x 203 mm)  
European A4: 210 x 297 mm  
European A5: 148 x 210 mm  
Banner European A4: 210 x 297 mm  
B5-JIS: 182 x 257 mm  
European DL envelope: 220 x 110 mm  
European C6 envelope: 114 x 162 mm  
European A6 card: 105 x 148 mm  
Japanese Hagaki postcard: 100 x 148 mm
Legal Information

Regulatory Notices

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions:
(1) This device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

Pursuant to Part 15.21 of the FCC Rules, any changes or modifications to this equipment not expressly approved by Hewlett-Packard Company may cause harmful interference, and void your authority to operate this equipment. Use of a shielded data cable is required to comply with the Class B limits of Part 15 of the FCC Rules.

For further information, contact:

Hewlett-Packard Company
Manager of Corporate Product Regulations
3000 Hanover Street
Palo Alto, Ca 94304
415.857.1501

NOTE: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of the FCC rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, can cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and the receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

Power Adapter Statement

The power adapter cannot be repaired. If it is defective it should be discarded or returned to the supplier.
Limited Warranty Statement

HP Product | Duration of Limited Warranty
--- | ---
Software | 90 Days
Ink cartridges | 90 Days
Printer | 1 Year

A. Extent of Limited Warranty

1. Hewlett-Packard (HP) warrants to the end-user customer that the HP products specified above will be free from defects in materials and workmanship for the duration specified above, which duration begins on the date of purchase by the customer. Customer is responsible for maintaining proof of date of purchase.

2. For software products, HP's limited warranty applies only to defects that arise as a result of normal use of the software and does not apply to defects caused by:
   a. Improper or inadequate maintenance or modification;
   b. Software, interfacing, media, parts, or supplies not provided or supported by HP;
   c. Operation outside the product's specifications.

3. HP's limited warranty covers only those defects which arise as a result of normal use of the product, and does not apply to any:
   a. Improper or inadequate maintenance or modification;
   b. Software, interfacing, media, parts, or supplies not provided or supported by HP;
   c. Operation outside the product's specifications.

4. For HP printer products, the use of a non-HP ink cartridge or a refilled ink cartridge does not affect either the warranty to the customer or any HP support contract with the customer. However, if printer failure or damage is attributable to the use of a non-HP or refilled ink cartridge, HP will charge its standard time and materials charges to service the printer for the particular failure or damage.

5. If HP receives, during the applicable warranty period, notice of a defect in any software, media, or ink cartridge product which is covered by HP's warranty, HP shall replace the defective product. If HP receives, during the applicable warranty period, notice of a defect in any hardware product which is covered by HP's warranty, HP shall, either repair or replace the defective product, as HP's option.

6. If HP is unable to repair or replace, as applicable, a defective product which is covered by HP's warranty, HP shall, within a reasonable time after being notified of the defect, refund the purchase price for the product.

7. HP shall have no obligation to repair, replace, or refund until the customer returns the defective product to HP.

8. Any replacement product may be either new or like-new, provided that it has functionality at least equal to that of the product being replaced.

9. HP's limited warranty is valid in any country where the covered HP product is distributed by HP except for the Middle-East, Africa, Argentina, Brazil, Mexico, Venezuela, and France's 'Departements D'Outre-Mer': for those excepted areas, the warranty is valid only in the country of purchase. Contracts for additional warranty services, such as on-site service, may be available from any authorized HP service facility where the product is distributed by HP or by an authorized importer.

B. Limitations of Warranty

1. TO THE EXTENT ALLOWED BY LOCAL LAW, NEITHER HP NOR ITS THIRD PARTY SUPPLIERS MAKE ANY OTHER WARRANTY OR CONDITION OF ANY KIND, WHETHER EXPRESS OR IMPLIED, WITH RESPECT TO THE HP PRODUCTS, AND SPECIFICALLY DISCLAIM THE IMPLIED WARRANTIES OR CONDITIONS OF MERCHANTABILITY, SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR PURPOSE.

C. Limitations of Liability

1. To the extent allowed by local law, the remedies provided in this Warranty Statement are the customer's sole and exclusive remedies.

2. TO THE EXTENT ALLOWED BY LOCAL LAW, EXCEPT FOR THE OBLIGATIONS SPECIFICALLY SET FORTH IN THIS WARRANTY STATEMENT, IN NO EVENT SHALL HP OR ITS THIRD PARTY SUPPLIERS BE LIABLE FOR DIRECT, INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES, WHETHER BASED ON CONTRACT, TORT, OR ANY OTHER LEGAL THEORY AND WHETHER ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

D. Local Law

1. This Warranty Statement gives the customer specific legal rights. The customer may also have other rights which vary from state to state in the United States, from province to province in Canada, and from country to country elsewhere in the world.

2. To the extent that this Warranty Statement is inconsistent with local law, this Warranty Statement shall be deemed modified to be consistent with such local law. Under such local law, certain disclaimers and limitations of this Warranty Statement may not apply to the customer. For example, some states in the United States, as well as some governments outside the United States (including provinces in Canada), may:
   a. Preclude the disclaimers and limitations in this Warranty Statement from limiting the statutory rights of a consumer (e.g., the United Kingdom);
   b. Otherwise restrict the ability of a manufacturer to enforce such disclaimers or limitations; or
   c. Grant the customer additional warranty rights, specify the duration of implied warranties.

3. FOR CONSUMER TRANSACTIONS IN AUSTRALIA AND NEW ZEALAND, THE TERMS IN THIS WARRANTY STATEMENT, EXCEPT TO THE EXTENT LAWFULLY PERMITTED, DO NOT EXCLUDE, RESTRICT, OR MODIFY, AND ARE IN ADDITION TO, THE MANDATORY STATUTORY RIGHTS APPLICABLE TO THE SALE OF HP PRODUCTS TO SUCH CUSTOMERS.

HP Year 2000 Warranty

Subject to all of the terms and limitations of the HP Limited Warranty Statement stated above, HP warrants that this HP Product will be able to accurately process date data (including, but not limited to, calculating, comparing, and sequencing) from, into and between the twentieth and twenty-first centuries, and the years 1999 and 2000, including leap year calculations, when used in accordance with the Product documentation provided by HP (including any instructions for installing patches or upgrades), provided that all other products (e.g., software, firmware) used in combination with such HP Product(s) properly exchange date data with it. The duration of the Year 2000 warranty extends through January 31, 2001.
Index

A
accessories
  phone numbers for ordering 76
  adding paper 8
addresses for ordering supplies 76
adjusters, paper 8, 9, 42, 44
aligning print cartridges 55
attaching the power cord 4

B
Banner switch 48, 80
banners
  choosing paper for 48, 81
  metric sizes 81
  minimum margins 73
  paper jams 50
  preparing paper for 49
  printing 48–50
Best mode 36
  print speed 79, ??–80
black print speed 79, 80
black resolution 80
bleeding ink 32
Book option 35
brightness of paper 30
business cards 44
business forms 32
button
  Power 4, 5
  Resume 45, 49, 67

C
cable
  connecting to HP JetDirect 300X
  External Print Server 10
  connecting USB 10
cable access door 10
  part number 74
  purchasing 74
cables
  connecting 4, 10
  recommended 74
capacity of IN tray 8
cards
  choosing paper for 44, 81
  metric sizes 81
  minimum margins 73
  non-standard sizes 45
  orientation 45
  printing 44
  stacking 44
cartridges, See inkjet print cartridges
  changing inkjet print cartridges 52
  charts 30
  child safety with inkjet cartridges 57
  Chooser
    selecting printer in 11
  choosing paper 30–32
  cleaning print cartridges 56
  cleanout access door, See rear access door
clear sheets, See transparencies
clearing jammed paper 67
closing top cover 6
coated paper 30
color
  paper choices 30
  printing 30
  resolution 80
color resolution 80
computer
  attaching the power cord 4
  CPU speed and print speed 72
  creating files from photos 38
  installing printer software 2–3
  RAM and print speed 72
connecting
  power adapter 4
  power cord 4
  USB cable 10
  using HP JetDirect 300X
  External Print Server 10
connection to printer 10
corrosion from refilled cartridges 60
cover, opening 5
cradles, cartridge 5
customer support 68
d D
dialog boxes, See HP print settings box and HP Toolbox
digital film processing 38
disks, ordering software on 68
door
  cable access 10
  purchasing 74
  rear access 67
top cover 1
door, rear access 67
double-sided printing, See two-sided printing
downloading new software 68
dried out cartridges 52
drying time
  printed photographs 39
transparencies 45, 46
duplex printing 34
  selecting paper for 30
  smeared ink 36
duty cycle 79, 80
e EconoFast mode 36, 46
  print speed 79, ??–80
electrical contacts on cartridges 5
electrical problems from refilled cartridges 60
electronic support 68
energy usage 80
envelopes
  choosing 40, 81
  damaged 32
  embossed 32
  maximum in a stack 41
  metric sizes 81
  minimum margins 73
  printing 40–42
  problems with 42
  shiny 32
  single-envelope slot 40
  small 42
types to avoid 32, 40
Index

with clasps 32
with windows 32
environment, operating 80
EtherTalk network connection choosing printer 11
system requirements vi

F
FCC statement 82
film processing 38
flip horizontal printing transparencies 46
foreign language User’s Guides 75
forms, multi-part 32
fuzzy printing 50

G
glossy paper 30
greeting cards 44

H
help online 68
technical support 68
Web sites and user forums 68
Hewlett-Packard papers 30
ordering from HP 75
Hewlett-Packard, reaching online 68
HP Banner Paper 31, 48, 76
HP Bright White InkJet Paper 31, 75
HP Customer Care 68
HP Deluxe Photo Paper 39
HP Direct 76
HP FIRST 68
HP Greeting Card Paper 31, 76
HP Iron-on T-Shirt Transfers 31, 76
HP JetDirect External Print Servers 74
HP Photo Paper 39
HP Premium Brochure and Flyer Paper 31, 75
HP Premium Glossy Hagaki Cards 76
HP Premium Inkjet Paper 31, 75
HP Premium Inkjet Rapid-Dry Transparencies 31, 45, 75
HP Premium Inkjet Transparency Film 31, 75
HP Premium Photo Paper 31, 39, 75
HP print settings box Book option 35
Tablet option 36
HP Restickables, Large Round Inkjet Stickers 76
HP Restickables, Large Square Inkjet Stickers 76
HP Toolbox 55
I
I/O interface 80
illustrations adding paper 8
banner switch 48
Book option 34
cleaning the cartridge cradle 58
cleaning the inkjet cartridges 58
closing top cover 6
connecting power adapter 4
connecting power cord 4
 cricket 5
electrical contacts on cartridges 5
IN tray 8
ink nozzles 5
inkjet print cartridges 5
inserting inkjet cartridges 5, 6
inserting single envelope 40, 41, 44
latches for inkjet print cartridges 6
loading cards 44
loading envelopes 40, 41, 44
loading labels 43
loading paper 8
loading transparencies 46
opening top cover 5
OUT tray 8
plugging in the power cord 4
preparing banner paper 49
printer connections 10
printing banners 48–49
printing envelopes 40–42
printing posters 47
removing the inkjet cartridges 57
single-envelope slot 40, 41, 44
sliding paper adjusters in 9, 44
sliding paper adjusters out 8
Tablet option 36
top cover 5
unpacking 1
IN tray 8
capacity of 81
use of 8
increasing printer performance 72
index cards 44
ink aligning print cartridges 55
bleeding 32
refilling print cartridges 59
repelled 32
replacing print cartridges 52
smearing 36
ink nozzles 5
inkjet labels, recommended 43
inkjet print cartridges 59
aligning 12, 55
cleaning to improve printing 55
craddles, illustrated 5
damage from refilling 59
dried out 52
electrical contacts 5
empty 52
ink nozzles 5
installing 5, 6
leaving in empty 6
light 53
ordering 74
part numbers 7, 52, 60, 74
placing cartridges in cradles 6
problems with 53
purchasing 59
refilling 59
removing 52
removing tape 5
replacing 52
storing 54
two required 6
using 54
inserting cartridges 5
Index

inserting single envelope 40, 41, 44
installing
    printer software 2–3
international
    User's Guides 75
invitations 30
iron-on transfers
    printing 51
    selecting paper 30
L
labels
    and paper jams 67
    choosing types to use 43, 81
    loading sheets 43
    printing 43
    types to avoid 43
landscape printing
    cards 45
latches for inkjet print cartridges 6
leaking from refilled inkjet cartridges 60
LED indicator statement 82
lights
    Inkjet Print Cartridge 5, 7, 53
    Power 5
    Resume 49
loading paper 8
    banner paper 49
    basic instructions 8
    card stock 45
    envelopes 42
    iron-on transfer paper 51
    label sheets 43
    photo paper 39
    transparencies 46
M
maintenance
    cleaning 72
    Web site address 59
manuals, ordering 75
margins
    banners 73
    minimums, by paper type 73
maximum envelopes in a stack 41
media size 81
media weight, recommended 81
metric paper sizes 81
modes, printing
    Best 79, ??–80
    EconoFast 79, ??–80
    Normal 79, ??–80
    printing speeds 79, ??–80
multi-part forms 32
N
noise emissions 81
Normal mode 46
    print speed 79, ??–80
O
online forums 68
online support
    maintenance Web site 59
opacity of paper 30
openings top cover 5
operating environment 79
ordering
    addresses for 76
    manuals 75
    software upgrades 68
    supplies and accessories 76
OUT tray 8, 81
P
packing materials, removing 1
paper
    adding 8
    bright white 30
    brightness of 30
    coated 30
    condition of 32
    for inkjet printers 32
    for photocopies 30
    for photographs 30
    for pictures 30
    for printing photographs 39
    Hewlett-Packard 30
    how to load paper 8
    list of types 31
    loading 8
    metric sizes 81
    minimum margins, by type 73
opacity of 30
part numbers 75
print side down 9
recommended types 30
selecting 30–32
size options 30
specifications 81
textured 32
trays 8
two-sided printing 30
types to avoid 32
types to use 30–32
weight of 30, 81
paper adjusters 8
paper jams 67
    banners 50
    can't find paper 67
due to poor paper condition 32
recovering from 67
paper sizes
    and minimum margins 73
    by paper type 81
paper tray
    capacity 81
    filling 8
paper type
    HP Deluxe Photo Paper 39
    HP Glossy Greeting Card Paper 45, 47, 48, 51
    HP Greeting Card Paper 45, 47, 48, 51
    HP Photo Paper 39
    HP Premium Inkjet Rapid-Dry Transparencies 45
    HP Premium Photo Paper 39
    HP Premium Transparency Film 45
    Other Photo Paper 39
    Other Transparency Films 45
    Photo Papers 39
    Specialty Papers 45, 47, 48, 51
    Transparency Films 45
paper, See banners, cards, iron-on transfers, labels
part numbers 7
    for inkjet cartridges 52, 60
    supplies and accessories 74
photographs
digital film processing 38
drying 39
effect of humidity 39
paper for 30
printing 38–39
recommended paper 30
recommended papers 39
scanning 38
pictures, paper for 30
plugging in the printer 4
postcards 44
posters
printing 47
power adapter 4, 74
part numbers 74
purchasing 74
statement 82
Power button 4, 5, 80
power consumption 80
Power light 80
power requirements 79
power socket 4
power strip, use with printer 4
preparing banner paper 49
print cartridge light 80
print cartridges, See inkjet print cartridges
print margins 73
print options
Banner 48
print problems 55
print quality
Best mode 36
cleaning inkjet cartridges 55
EconoFast mode 36, 46
for printing photographs 39
Normal mode 46
smearsed ink 36
transparencies 45
using refilled inkjet cartridges 59
print quality problems 55
print servers
HP JetDirect 170X 74
HP JetDirect 300X 10, 74
HP JetDirect 500X 74
HP JetDirect EX Plus 74
HP JetDirect EX Plus 3 74
part numbers 74
print settings
photographs 39
two-sided printing 34, 37, 39
print settings box, See HP print settings box
print side of paper 9
print speed
black 79, ??–80
color 79, ??–80
specifications 79, ??–80
transparencies 45
print technology 80
printer
additional information online 68
aligning cartridges 12
cable types 10
choosing with EtherTalk connection 11
choosing with USB connection 11
connecting to HP JetDirect 300X External Print Server 10
connecting to USB cable 10
connections 10
dimensions 80
documentation Web site 75
driver and print quality 72
driver upgrades 68
how to plug it in 4
IN tray 8
increasing performance 72
loading paper 8
OUT tray 8
paper adjusters 8
paper capacity 8
paper trays 8, 81
power cord 4
powering on 4
specifications 79
speeds 79
supplies and accessories 76
turning on and off 4
unpacking 1
User’s Guides 75
weight 80
printer drivers
and print quality 72
upgrades 68
Printer Services tab
aligning the inkjet cartridges 55
cleaning the inkjet cartridges 55
printer software 14
HP print settings box 14
installing 2–3
upgrades 68
printing
banners 48–50
cards 44
envelopes 40–42
iron-on transfers 51
labels 43
photographs 38–39
posters 47
quality 55
sideways, See landscape
transparencies 45–46
two-sided 34
problems
damaged paper 32
envelopes 42
ink not drying on labels 43
ink streaks 55, 56, 59
inkjet print cartridges 59
only one inkjet cartridge 54
paper ejection 67
paper jam 67
paper types to avoid 32
poor print quality 55
preventing for cartridges 54, 57
print cartridges 59
printing banners 50
printing envelopes 40, 42
printing transparencies 46
sheets of labels 43
Index

smeared ink 36
using refilled inkjet cartridges 59

Q
questions about your printer 68

R
rear access door 67
part number 74
purchasing 74
recipe cards 44
recommended papers
for banners 48
for cards 44
for transparencies 45
iron-on transfers 51
list of 31
part numbers 75
photographs 30
suggested uses 30
types to avoid 32
recommended temperatures
for inkjet cartridges 54
refilling inkjet print cartridges 59
regulatory notices 82
replacement cartridges 7
replacing inkjet print cartridges 52
resolution 80
Resume button 45, 49, 67, 80
Resume light 80

S
scanning photographs 38
sideways printing
See landscape
single envelopes 40
size
media 81
paper 30
specifications 81
sliding paper adjusters in 42, 44
smeared ink 36
smoothness of paper 30
software
installing 2–3
software compatibility 80
software upgrades 68
special papers 75
specifications 79, 80
speed, printing 45, 79, ??–80
storing inkjet cartridges 54
stuck paper, See paper jams
supplies, phone numbers for
ordering 76
support, maintenance Web site 59
switch, banner 48
system requirements
EtherTalk network connection vi
USB connection vi

T
Tablet option 36
tape, on inkjet print cartridges 5
technical specifications 79
technical support 68
telephone numbers for ordering
parts 76
temperature range for cartridges 54
textured paper 30, 32
top cover 5
part number 74
purchasing 74
transfers, iron-on 51
transparencies
adhesive strip 46
choosing types to use 45
print quality 46
printing 45–46
problems 46
writing on 45, 51
trays
adjusters 8, 9, 42, 44
IN 81
OUT 81
troubleshooting 61–69
t-shirts, iron-on transfers 51
turning the printer on and off 4
two-sided printing 34
Book option 35
paper 30
problems 36
selecting paper 30

U
unpacking printer 1
upgrades for software 68
USB connection
choosing printer 11
system requirements vi
user forums 68
User’s Guides 75

W
warranties
extensions 70
refilled cartridges excluded 60
warranty statement 83
Web site
maintenance 83
weight
paper 30, 81
recommended media 81
window envelopes 40
Environmental Attributes of the DeskJet Printer

Environmental Statement
Hewlett-Packard continuously improves the design and production processes of HP DeskJet printers to minimize the negative impact of the office environment and on the communities where printers are manufactured, shipped, and used. Hewlett-Packard has also developed processes to minimize the negative impact of the disposal of the printer at the end of printing life.

Reduction and Elimination

Ozone: All ozone-depleting chemicals (CFCs, for example) have been eliminated from Hewlett-Packard manufacturing processes.

Number of Parts: Early in design, the total number of parts used by the printer is reduced when possible to minimize costs during manufacturing and to reduce handling at end-of-life.

Printer Packaging: The packaging materials for this printer have been selected to provide maximum protection for the least cost possible, while attempting to minimize environmental impact and facilitate recycling. The rugged design of the HP DeskJet printer assists in minimizing both packaging materials and damage rates.

Recycling
Design for recycling has been incorporated into this printer. The number of materials has been kept to a minimum, and dissimilar materials have been designed to separate easily. Fasteners and connectors are easy to locate, access, and remove using common tools. High priority parts have been designed to be accessed quickly for efficient disassembly and repair. Plastics parts have been primarily designed in no more than two colors to enhance recycling options.

Plastic Materials: All major manufactured plastics parts are marked as to the plastic content to facilitate product recycling.

Printers and Print Cartridges: In certain countries, Hewlett-Packard is conducting pilot programs to take back printers and print cartridges for material reclamation and environmentally sound disposal. Call your Hewlett-Packard representative for current status.

Paper: This printer is designed to facilitate the use of recycled paper as consumer media. Depending on the availability of recycled paper in each country, all manuals are printed on recycled paper.

Energy Conservation
This printer was designed with energy conservation in mind. This printer uses less than 5 watts in stand-by mode. As an ENERGY STAR partner, Hewlett-Packard has determined that this product meets the ENERGY STAR guidelines for energy efficiency.

Off-mode Energy Consumption: When the printer is in off-mode, a minimal amount of energy is still being consumed. Turning off the printer and then disconnecting the printer power cord from the electrical source can prevent energy consumption.
Your DeskJet Connection!

Information on more products:
http://www.hp.com

HP Customer Care:
http://www.hp.com/support/home_products

*Information in these web sites may only be available in English